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Chapter 1 How To Use This Manual
1. How To Use This Manual

Introduction

Welcome to the Magaya Software Customization Manual.

This manual is designed to teach you how to customize and automate your 
Magaya software to meet the needs of your individual business.

Magaya software is designed for logistics providers, freight forwarders, 
NVOCC’s, consolidators, forwarding agents, couriers, warehouse providers 
and others in the logistics industry. Magaya software contains many customiza-
tion options, operations functions, trade documents, and a complete 
accounting system that integrates the accounting and operations functions.

How this Manual is Organized

This manual is designed to be task oriented. You can skip to any topic you need 
and get step-by-step procedures for the customization options available in 
Magaya software. You can also click on any word in the Index to go directly to 
that topic in the PDF. This manual is organized into the following sections:

• Automated Accounting: Customize your software to automate the 
creation of charges; set up recurring accounting transactions for invoices, 
bills, and checks; create periodic invoices; set up tariffs and rates for 
carriers and customers

• Configuration Menu: Use these options to set up document numbering, 
enter custom clauses to use in shipments and other transactions, set up 
transaction tracking, define tasks, and many other options

• Custom Fields: Create your own customized fields to gather information 
that is specific to your business and use it in transactions, documents, and 
reports

• Divisions: Enter information about different divisions in your company 
and use that information in documents

• Customize Documents: Customize existing documents such as invoices 
and warehouse receipts, or create new, custom documents to display your 
1
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company logo, custom fields, and more using the Magaya Document 
Designer program that is included with all Magaya software

• Insert JavaScript into a Template: Customize your software by adding 
JavaScript into templates that your company can use

• Magaya Database Administrator: Access the functions of the Magaya 
Database Server Agent to create a backup of your database, create a 
custom schedule of backups, and more

• JavaScript Basics: A resource of basic information on variables, opera-
tors, mathematical functions, and conditionals

Contact and Help Resources

Help with the software is available in a few different places and formats for your 
convenience. We know that reading a full user manual isn’t for everyone, so we 
also have a searchable knowledgebase that you can access from Page One, the 
welcome screen in your software.

Page One is the welcome screen in your software with links to resources and to 
Magaya Tech Support. You can request Tech Support and check on the status 
of a request, find the user manuals and link to the Knowledgebase to search for 
topics.

Click the Help menu in the top toolbar of your software to access resources such 
as videos, user manuals, the Knowledgebase, and more.

Tips and suggestions are available in Magaya software on dialog boxes and other 
locations in the software program.
 2



Chapter 1 How To Use This Manual
Hover over the “Magaya Tip” button to see a quick tip or link to more resources 
such as how-to articles and videos.

It is recommended to leave the Tips on, but your system can be set to turn it off; 
go to: the Maintenance folder > Configuration > General.

Video tutorials are on www.magaya.com and YouTube.com

If you have any questions or require assistance, please contact Magaya at:

Phone: (786) 845-9150

Email: support@magaya.com
3
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You can request Tech Support from Page One, the welcome screen in your soft-
ware, and check that status of an existing support case.

Use of the Magaya software and its documentation are governed by the terms 
set forth in your license.

Copyright © 2017 by Magaya Corporation. All rights reserved.
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Automated Accounting

Introduction to Automated Accounting

Magaya Explorer provides options to automate the creation of accounting 
transactions. This process is divided into two steps: 1) First, create the transac-
tion, and 2) tell the system how to calculate the prices.

1) Automated creation of accounting transactions is done with the following 
features:

• Automatic creation of charges in operations and when working with 
routes

• Recurring accounting transactions

• Periodic invoices

2) Calculate the prices or fees for the created transactions with the following 
features:

• Tariffs

• Rates for carriers and clients (i.e., your customers)

• Manage contracts

Automated Creation of Charges

Magaya Explorer enables you to add charges and make them appear automati-
cally in operations transactions. If you set up charges and tell the system to add 
them to transactions automatically, then the charges will appear each time that 
type of transaction or document is created. The charges are also carried over 
from one transaction to another when you convert one into another. For 
example, charges added to a Pickup Order or Warehouse Receipt are carried 
over into a Shipment when the transaction is converted. The created charges 
will also be used later in the liquidation to create accounting transactions.

Existing charges in your Magaya system can be automated, or you can create 
new ones and automate them.

Set Up:
6



Automated Accounting Chapter 2
Go to Maintenance > Configuration > Automatic Charge Generation. Verify 
the checkbox is checked to allow automatic generation of charges. The setting is 
on by default and set to use the current date. Modify the date setting as needed.

To set up automation on existing charges, follow these steps:

1) Go to the Accounting folder in Magaya Explorer > Items and Services.

2) Select an item that you want to automate, for example, the Cartage Fee. In 
this example we will add a charge to each containerized ocean export ship-
ment for taking the container to the port. Double-click on "Cartage Fee" 
(or select it and click the Edit button).

3) The “Items and Services” dialog box for the Cartage Fee opens:
 7



Chapter 2 Automated Accounting
Click the “Automatic Creation” tab and follow these steps:

Activate the checkboxes by clicking on the box next to “Enable Automatic 
creation for:” and a checkmark will appear in the box (1).

Check Ocean House Shipment (OHE) under the Export Shipments list (2).

Click on the “Modes of Transportation” button (3):

• In the screen that opens, uncheck the box to "Apply this charge to all the 
modes of transportation available (1). Then uncheck the other boxes 
8
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"Vessel" and "Barge" so only the “Vessel, Containerized” option is checked 
(2):

Click OK in the Appliable (applicable) Modes of Transportation dialog 
box to return to the Items and Services dialog box. (Using the Modes of 
Transportation button is optional, but for this example we used it because 
we want only the “Vessel, Containerized” mode.)

• To allow the charges to appear in the operations documentation that is 
viewable to customers, leave the checkbox blank for “Do not Show in 
Documents.” If you do not want the charges to appear in the operations 
documents, check the box.

• If the price for this charge depends on other charges, click this checkbox. 
For example, if you include an insurance charge in a transaction, that 
charge depends on the freight and value of the cargo (which will be calcu-
lated first). The Priority setting only applies to how the charge will be 
displayed in documents, LiveTrack and Transaction Tracking. See more 
details on these functions in the chapter “Items & Services.”

• Click the OK button when done.
 9
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Result: When you are done, the Items and Services list will show which transac-
tions have charges that will be automatically created.

In this example, when an Ocean House Export (OHE) shipment is created and 
"vessel containerized" is selected as the mode of transportation, a charge for 
Cartage Service will be added to that house shipment. (Charges created auto-
matically will always be added after you selected the "client to bill" for that trans-
action.)

The price of the created charge will be calculated based on the tariff or rate set 
for that charge. See the section on Tariffs for details.

Note: In addition to adding the Automatic Creation functionality to an existing 
Item or Service, you can also add a new Item or Service and automate charges 
for it. For example you may want to automate an Express Shipment Surcharge 
for high-priority shipments. Then, each time you create a high-priority ship-
ment, the surcharge will be added. Use the Add button in the Items and Services 
list to add a new item and automate the charge, following the same steps above.

Any automated charges you create will be added to online shipping orders as 
applicable when your customers create Pickup Orders, Cargo Releases, or Ship-
ments in Magaya LiveTrack.

Note: If you want charges to be automated in online sales orders, enable the 
charges you want from the Items & Service list, and then activate this option in 
the Configuration > Online Sales Orders > “Generate charges automatically for 
online sales orders.” Then customers will see the charges online.
10
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Automate Charges per Customer

You can also automate or override charges per customer on the Charges tab of 
the Customer profile dialog box. For example, you can add an income item that 
applies to this customer.

1) Open the Customer profile dialog box, go to the “Charges” tab, and click 
“Add.”

2) Select the charge. You can select income or expense charges.

3) Enter a fixed price or set a tariff. (For help setting a tariff, see the section 
“Customize a Tariff.”)

4) Optional, depending on the type of accounting transaction you are 
creating: Select the vendor to apply the cost to, if this is an expense for you. 
This option is useful when you perform work for a customer and incur 
expenses that you need to pay to a vendor.

If you do not want the charge to appear in documents, check the box.

If the calculation of this charge depends on other charges in the transaction, 
check the box.

If you want to make this charge automatically appear in certain transactions, 
click the tab “Automatic Creation” and select the transaction.

Click “OK” to save the charge and again to save it for the customer profile.
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Creating Charges from Routes

In Magaya software version 9.0 and higher, there is a feature that enables you to 
create routes and add charges for them. The routes management feature creates 
segments and routes for multimodal shipments.

• You can add costcharges for routes, and those charges will appear auto-
matically on the Master of a shipment that you create using the route.

• When you add salescharges to a route, that charge will appear on the 
House section of a shipment transaction.

If a shipment does not have a route selected, your Magaya system will create 
charges will use the automatic creation of charges setting.
12
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Recurrent Accounting

Introduction to Recurrent Accounting

In Magaya Explorer you can set up recurring accounting transactions for:

• Invoices

• Bills

• Checks

For example, you can create a recurring invoice for your regular customers such 
as suppliers who store goods in your warehouse. The recurrent invoice charges 
them every month for storage. A wizard walks you through the setup so you do 
not have to create the invoice each month or other time period you set.

Set Up Configuration:

Go to Maintenance > Configuration > Accounting > on the Miscellaneous and 
check the option “Automatically generate recurrent transactions.”

Create a Recurring Invoice

To create a recurring invoice template in Magaya Explorer, follow these steps:

1) Go to the Invoice List.
13
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2) Click the Actions button and select “Recurrent Invoices:”
 14
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When the list of recurrent invoices opens, click the “Add” button:

A dialog box opens the Recurrent Transaction Wizard. This wizard will create 
a template for a new recurring invoice. All future invoices for this customer will 
be built on this.

Every month when the system automatically generates the next recurring 
invoice for the customer, this template will be used. The date and charge 
amounts will be updated each month to reflect the new charges, while the other 
elements of the template such as the customer’s address will be the same. You 
will not have to re-enter the information. If you need to change something such 
as the address in the future, you can edit the recurrent invoice by using the Edit 
button.
15
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The first screen in the Recurrent Transaction Wizard contains the following:

• Enter the transaction number in the “Number” field. This is the number 
of this template, not the number of the invoice. The invoice number will 
be generated at the moment that the invoice is automatically generated.

• Click on the “Apply to” dropdown menu to select the customer that will 
receive the recurrent invoice. The address displays automatically. To 
change it for this transaction, click the Change button. The date is filled in 
automatically.

• Select the Account this transaction will refer to such as Accounts Receiv-
able.

• The Transaction Date is set automatically to today’s date. Change it as 
needed. This is the date that you created this template.
 16
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• Click the “Add” button in the wizard screen to add a charge. A dialog box 
opens:

– a) Select the type of charge such as Storage Fee (whic is an Income 
item).

– b) Enter a description (optional).

– c) The quantity, units (such as pounds), and the price will be calcu-
lated by the system automatically each time the invoice is generated. 
A price can be added if you want to have a set charge not based on 
the cargo on hand.

– d) Click the OK button to save this charge and return to the wizard 
screen.

• Set the “Paid as” option to either Prepaid or Collect based on the terms of 
the agreement for this recurring invoice.

• Click the “Next” button to go to the next screen in the wizard.
17
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The next screen in the wizard enables you to set the frequency of the invoice.

• Select the start date. Today’s date is filled in automatically. Change it as 
needed. This is the date that the system will begin generating these 
invoices. You may create the invoice template to begin invoicing the 
customer starting next week, for example. Next week’s date will be used in 
the invoice. You can also set up retroactive recurrent invoices by using a 
past date.

• Set the end date, or check “Never Ends” if the service is continuous.

• Generate: Select the frequency that you want to generate the invoice: If 
you select Monthly, also select the day of the month (1-31) If you select the 
31st, the system will default to the 30th for months that do not have 31 
days. If you select Weekly, the invoice will be generated on Fridays.

• You can charge the customer in advance by clicking on the checkbox. If 
not, uncheck the box (it is unchecked by default). When charging monthly 
in advance, the customer is paying for that whole month in advance.

• The checkbox for “On Hand” cargo in the warehouse is used for fees. The 
box is unchecked by default. Checking the box activates the fields below it.

Use this option to calculate the fee on the invoice based on the amount of 
cargo on hand for the client. The price will be calculated based on the tariff 
 18



Chapter 2 Recurrent Accounting
you set up; in this example it is for storage. See the section on “Tariffs and 
Rates” for details.

If you want to give a customer some free days before charging for services 
such as storage to encourage quick movement of cargo, add the number of 
days in the days field “Amount of days before.”

• Other options are:

Generate a separate charge per line item. The number of charge lines in 
the resulting invoice will be the same as the number of cargo lines in the 
related warehouse receipt. This is useful to itemize oversized cargo.

Calculate charges based on the smallest packing unit. (If unchecked, the 
price will be calculated by pallet.) If the cargo is repacked in pallets, the 
price will be calculated based on the items inside the pallet.

You can also disable the recurring transaction by clicking in the Disable 
box.

• Click the “Finish” button.

Result: The recurring invoice template is added to the list of Recurrent Invoices. 
On the first of the month (or preset day), a new invoice will be created for that 
customer. The invoice appears in the Invoices List.

If you are using the PayCargo service, you can send the invoice to that service so 
the customer can pay it online; or you can give the customer Magaya LiveTrack 
permissions to pay the invoice themselves online. For details on setting up this 
service, please see the Magaya Software Communications Manual.

Note: You can also save an existing invoice as recurring by clicking on the 
Actions button when you are in the document view of the invoice:

The wizard opens. Fill in the fields as explained above. (You can also save an 
existing invoice as recurring when you are in the Invoices List. Right-click on 
the invoice and select “Save as Recurrent” from the pop-up menu.)
19
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Create a Recurring Bill

To create a recurring bill:

1) Go to the Bill List in the Accounting folder.

2) Click the Actions button and select Recurrent Bills:

The list of recurrent bills opens. If you have not created any recurring bills yet, 
the list will be blank.

In the Recurrent Bills list, click the Add button. A dialog box opens the Recur-
rent Transaction Wizard. This is the same wizard used to make a recurring 
invoice. See the section on recurring invoices for details.

You can also create a Recurring Bill from an existing bill: Go to the document 
view of the bill and click on the Actions button. The same Recurrent Transac-
tion Wizard opens. Follow the steps above.

Create a Recurring Check

Recurring checks can be created to pay for expenses that you have on a regular 
basis such as paying rent or insurance every month.

To create a recurring check:
 20
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1) Go to the Checks List, click on the Actions button. Select “Recurrent Checks”.

A new list opens. If you have existing recurrent checks in the system, they will 
be displayed in the list. If you do not have any, the list will be blank.
21
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2) Click the Add button to add a new recurring check. A “Recurrent Transaction 
Wizard” dialog box opens.

• Select the bank account you want to use to pay this recurring check.

• Select who to pay this check to for the “Pay to the order of” dropdown.

• Optional: Enter a memo (note) if needed. Select a Division if applicable.

• Click the “Add” button. A line in the Detail table will be highlighted. Click 
in each field to enter information or use the dropdowns as they become 
active.

The total will be calculated.

• Click the “Next” button. The next page of the wizard enables you to set the 
frequency of the recurring check. The fields on this screen are the same as 
for creating a recurring invoice.

You can also create a recurring check from the document view such as right 
after you write a “Check to Expense” type of check. (The other types of checks 
cannot be made into recurring checks.) Click on the Actions button. Select 
“Save as Recurrent.” The same wizard dialog box will open.
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Actions for Recurrent Transactions

In the Recurrent Invoices list (and the Recurrent Bills list), click on the Actions 
button to access the following options:

• Generate Recurrent Transactions: If there are transactions due to be 
generated, they will be generated when you click the button. Otherwise, a 
note will state that there are no transactions to generate at this time. When 
you log into the Magaya system, you will receive a notice if there are any 
transactions to be generated (if you have accounting permissions). You 
can click “Yes” to generate them or “No” to generate them at another time.

• Update On Hand Cargo to bill: A note pops up to notify you that the 
update is in progress. This will link a new recurrent transaction with ware-
house receipts previously received for the customer. This is normally done 
automatically, but this manual option is available.

• Choose Columns: As with any list, you can choose the columns and their 
arrangement.

• Export: You can export the list from your Magaya system.
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Periodic Invoices

A Periodic Invoice will gather all the charges for a customer and place them on 
one invoice during a week or month.

Steps

1) First, to enable this function for your Magaya system, go to the Maintenance 
folder > Configuration menu and select the Accounting section.

• In the Accounting configuration options, select the time frequency of the 
periodic invoices. Use the dropdown menu to choose Weekly (Fridays) or 
Monthly (select up to five dates during the month).

Save your settings.

2) To set up Periodic Invoices for specific customers:

• Go to the Maintenance folder and click on “Customers”.
24



Periodic Invoices Chapter 2
• Select the customer that you want to create a periodic invoice for 
(double-click on the name to open the Customer dialog box).

• Go to the Payment Terms (“Pmt Terms”) tab:

Note: The only items on this tab that will be discussed here are the ones related 
to periodic invoicing. (The TSA known shipper is covered in the Magaya Cargo 
System Operations Manual.)

You can select how often you want to invoice by clicking the dropdown menu 
“Invoice periodically”:

• Use default: This will use the default you preset in the Maintenance > 
Configuration menu that applies to all customers.

• Never apply: Use this to turn this feature off.

• Weekly: This customer will be invoiced every week. All the operations 
charges during the week will be added to an invoice each Friday.
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• Monthly: When you select this option, additional fields appear so you can 
set up to five separate dates to generate invoices. This customer will be 
invoiced on the dates you select.

When you are done, click the OK button to save.

Periodic Billing for Vendors

The system provides the option to group all the bills generated for a vendor in a 
period (week, month).

To enable this option, go to the Payment Terms (Pmt. Terms) tab of the Vendor 
profile.

For example, set up the monthly billing period for a vendor such as an insurance 
broker so that every time a new insurance certificate is created, the system adds 
the cost charge of the insurance to this monthly bill.

This guarantees that the bill created matches the monthly insurance invoice 
generated by the broker for the same month. If this is not done, you will have as 
many bills as insurance declarations submitted during the month to match one 
invoice.
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Tariffs and Rates: Introduction

Introduction to Tariffs and Rates

Tariffs and Rates can be set up in Magaya Explorer to calculate prices for trans-
actions. The difference between Tariffs and Rates is:

• Tariffs are prices you set for services that you offer. The price depends on 
the measurement, value, and storage time of the cargo.

• Rates are calculated based on the measurement information plus the 
mode of transportation, and the origin and destination information for 
the cargo.

How to use Tariffs and Rates: Tariffs are most often used for charges that are 
static such as storage, insurance, etc. Rates are for freight charges.

How the system will process the tariffs and rates:

1) First the system will look in the Customer profile for the rate that is based 
on origin, destination, mode of transport, and cargo measurements. If 
there isn’t a customer rate, then:

2) The system will look for a tariff (which is on the Charges tab of the 
Customer profile) based on cargo measurements, time, and value. If the 
system does not find one, then:

3) The system will check the Standard Client Rates based on origin, destina-
tion, mode of transport, and cargo measurements. If the system does not 
find one, then:
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4) The system will check for a tariff in Items and Services based on cargo 
measurements, time, and value.
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Tariffs

Tariffs: Introduction

Tariffs are prices you set for services you offer such as refrigerated storage. The 
price depends on the measurement (pieces, weight, and volume) value of the 
cargo, and the time it is in storage. Let’s see how to set up tariffs in Items and 
Services under the Accounting folder.

The Tariff button is available on each Items and Services dialog box.
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How to Set Up Tariffs

Follow the steps below to set up tariffs in your Magaya Explorer.

1) In the Items & Services folder, open an item or a service and click on the 
Tariff button. A dialog box opens:

The tariff will be calculated in the currency that is selected in the Items and 
Services screen. The screenshot above shows “Prices in USD”.

Select the option you want in the “Apply by” field:

Weight: This gives you the option to select the weight units (pounds, kilo-
grams, ton, ounce, or Troy ounce).

Min/Max: In the Tariff dialog box, you have the option of entering a 
minimum and maximum price: Enter the amount in the fields “Min.” and 
“Max.” as needed.

Rate per unit: Set the unit as needed. For example 50 cents for every 2 
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pounds (lb).

When charging by weight, the Tariff screen lets you charge a rate that 
varies based on the weight (range).

Example: For shipments that weigh more than 1 pound but less than 50 
pounds, the rate might be 1.00 per pound. For a shipment weighing 51 to 
100 pounds, the rate might be 0.75 per pound.

Click on the Add button. This activates the cells in the table.

Click in the table cells to enter information. Click the OK button to save. 
Note: These table cells can be used for entering tariffs by weight, pieces, 
volume, time and value.

Pieces: When setting the tariff by Pieces, the weight unit dropdown is not 
available because it is not needed.

Volume: This gives you the option to set the units by Cubic meters, Cubic 
inches, Cubic centimeters, or by Liter.
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Time: This gives you the option to charge by time (Hours, Minutes, 
Seconds, Days, Weeks, or Months).

The Time is calculated based on the time the cargo arrived (based on the 
Warehouse Receipt time), and the time the cargo left the warehouse (via 
Cargo Release or Shipment).

Value: The value is used to charge based on the value of the merchandise 
and it can be used to calculate the amount of the insurance on the cargo. 
When selecting “Value”, the unit dropdown is not available.

Calculated: This gives you the option to calculate the tariff based on a 
script or a formula:

The “Formula” option gives you buttons for Variables, Operators, and Validate.

The following example shows how to calculate a storage charge of 0.02 per day 
per pound.

First, click the Variables button to set the variables for Time (T) to “Days” and 
set Weight (W) to “Pounds”.
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The Variables screen shows a list of variables names and codes. These are the 
variables you will use in the script or formula and the measurement units that 
they will come in.

Enter the formula in the blank field using the Variables and Operators:

Click the “Operators” button to insert operator symbols to multiply, divide, etc.

Click the OK button when you are done. You will be returned to the Tariff 
dialog box.
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To create a formula that rounds the days and pounds up to the next integer 
(whole number), use the “ceiling” function:

To validate the formula, click the Validate button and enter numbers to test it.

The option to calculate by “Script” shows a screen with a button for variables 
(weight, volume, etc.), a button to edit code, and a validation button.

Click the “Edit Code” button to open a screen to type in JavaScript code. This 
screen is used to type the body of the JavaScript function to calculate the price. 
The function brackets are already included in the header and the closing bracket 
is included at the bottom of the screen. The “return” statement is required to 
pass the calculated price back to the Magaya system.

This code example shows the storage charge that rounds up to the next number:

In the script code screen, you can call functions by name if you have functions 
already created in the Maintenance > Configuration > JavaScript Code library. 
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This is covered in detail in the “Configuration Menu” chapter of the Magaya 
Software Customizatin Manual. Validate the code to check for errors. Save it.

Tariff by Percent:

To calculate by percent, select the “Percent” option.

Enter a minimum and maximum (optional), enter the percent amount such as 
5% and how to apply it: to the cost, income or profit.

This percent option can calculate a percent for a commission. If it is used in 
House Shipment, it will only calculate the commission for that House, not the 
cost of Master prorated.

Click OK to save and close this screen and the previous one.

Note: The percent option was introduced in Magaya software version 9.8. It was 
designed to make it easeir to set the percent of a tariff. If your system has existing 
tariffs that calculate a percent with a formula or script, your system will 
continue to use those.

Result: Now the tariff is ready for use in transactions.
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How to Customize a Tariff

You can customize a tariff for a specific client (customer).

1) Go to the Maintenance folder > Customers.

2) Select the customer and open their profile. Then click on the Charges tab.
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3) Click on the Add button.

In the dialog box that opens, set up the custom tariff.

• Select the Charge that you want to customize from the dropdown.

• Enter a price or click the Tariff button. (If you select a freight charge, 
the Price field will change to a note “Freight Charges Use Rates.”)
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• If you want to automate this charge, click “Automatic Creation” tab. 
Select the transactions to automate.

• Click OK when done.

That tariff will now apply to that customer for the transactions you specified.
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Rates

Rates Overview

Rates are used to calculate prices for services related to the movement of cargo. 
They are calculated based on the measurement information plus the mode of 
transportation, and the origin and destination information for the cargo.

The different types of rates are: standard rates for all your customers (clients), 
rates from your carriers, and customized rates applied to individual customers:

• Carrier Rates: These are your purchasing rates for freight services, how 
much you pay the carrier.

• Standard Client Rates: These are your standard rates for all customers. 
You can make these available on Magaya LiveTrack for your customers to 
view.
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• Client Rates: This groups all the rates for all your customers (clients) in 
one place. You can customize multiple and single rates for customers 
using a wizard that is available in the Client Rates folder.
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The Rates folder also contains contracts. See the sections on contracts for 
details. The next section will focus on setting up carrier rates.

Rates can be used in Pickup Orders if you set the “Place” field on the Shipper tab 
or the Consignee tab. See the Pickup Orders topic for details:

http://knowledge.magaya.com/#/article/create_pickup_order

Rates can be added individually or in bulk. To import rates in bulk into your 
system, use a CSV or XML file. For steps, see the topic “Import Rates” in the 
Knowledgebase:

http://knowledge.magaya.com/#/article/import_rates
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Carrier Rates

Overview to entering new rates from your carriers: The article explains how to 
add a single rate from a carrier and how to enter multiple rates from the carriers 
you use for air, ocean and ground transport.

To learn how to import a list of rates, see the Knowledgebase article, "Getting 
Started: Importing Data using the Import Wizard:"

http://knowledge.magaya.com/#/article/import_wizard_tips

Enter Carrier Rates

Carrier Rates are your purchasing rates for freight services (how much you pay 
the carrier). For each carrier that you use, enter the rate information they give 
you in your Magaya system. This rate will be used as the Cost in freight charges.

To set up the carrier rates, follow these steps.

• Open the Rates folder, and click Carrier Rates.

• Click the Add button and select the type of rate you want to enter: A single 
rate or multiple ones:
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This example will illustrate how to add a single rate. Multiple rates is explained 
in the section “Add Rates to a Carrier Contract.” The single rate will apply to 
one carrier for one transport mode and only for one origin/destination.

In Magaya software there are many options for creating rates:
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A dialog box opens. The following example shows an ocean rate:

• On the General tab, select the carrier (or add it if it is not in the list).

• Select the freight class service. This pulls from the Items and Services of 
type “Freight” and “Other Freight”.

• Enter a description (optional). Use this for Commodities that you want to 
classify by type such as electronics. To enter a new commodity, click on 
the plus sign in the dropdown menu, enter the information and click OK. 
Commodity Types can also be entered in Maintenance > Configuration > 
Commodity Types. The Commodity Type can also be specified when you 
are entering Inventory Item Definitions: Select the Commodity field on 
the General tab.

• Select the origin and destination cities for this rate (from the ports list).

• Select the method (mode of transportation) such as “Vessel, Container-
ized”.
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• Transit Time: Enter the number of days of the voyage. (This information 
can be added to the Query Rates screen.)

• Select how to apply the rate: This example uses “Container”. When you 
make this selection, the screen will change depending on what you select.

• Minimum and Maximum prices: Set this option as needed.

• Rate per: Set the rate per unit or per range. Rates per Unit such as pounds 
will multiply the rate by the unit.

If the unit is 1 pound and the price is $1 per pound for weights between 1 
and 50 pounds, to ship 35 pounds will be calculated as 1 x 35 to equal $35.

If the price is 0.80 per pound for shipments weighing between 51 and 100 
pounds, the price for a 70-pound shipment will be calculated as 0.80 x 70 
= $56. The price for 90 pounds will be calculated as 0.80 x 90 = $72.

If you set the unit to equal 100 pounds, and the price of $10 per each unit, 
then shipping 400 pounds will be calculated as 4 units of 100, which will 
cost $40.

Select Rate per Range: Enter the ranges such as 1 to 20 cubic feet, then 21 
to 50 cubic feet, etc. For example, a range is set for $10 for any measure-
ment between 1 to 20 cubic feet; your shipment is 15 cubic feet, the price 
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is calculated at $10. If a shipment is 11 cubic feet, the price is still $10 
because it is in the range of 1 through 20.

Rates per range are useful for Roll On Roll Off (RORO) rates. To set a 
RORO rate, apply the rate by volume (cubic feet) and select Rate per 
Range and enter your numbers.

• Click the Add button to add a rate. This will activate a line in the Prices 
table. Select a container (this example shows a 20-foot and a 40-foot stan-
dard container) in the Prices table, and enter the rate for each in the fields. 
You can add as many as you need.

If you have a contract with a carrier, click on the Contract tab:

• Enter the date the contract expires. When the contract expires, the rate 
will no longer be used.

• Enter the contract number.
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If you want to add any notes, click on the Notes tab and enter them.

Click the OK button when done.

Result: The rate now displays in the Carrier Rates list and is available to use for 
costs in shipments.

Note: You can also set up carrier rates in the Maintenance folder by selecting the 
carrier (if they are in the list already). To create a new carrier profile, click on 
the Add button and select the type of carrier:

To edit an existing Carrier rate, double-click on it (or select it and click on the 
Edit button).

In the dialog box that opens, click the Rates tab. To edit a rate, click on the “Edit” 
button. To add a new rate, click on the “Add” button.

This opens the same dialog box explained above.

You can also edit the rates for an existing carrier by right-clicking on the carrier 
name in the Carrier List and select “Rates” from the pop-up menu. In the screen 
that opens, click on the Add button. Use the wizard to enter the information.
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Actions in the Carrier Rates List

Click on the Actions button in the Carrier Rates list to access the following 
options:

• Reports: Use this to create a report of all carrier rates.

• Other Reports: Use this to create reports by carrier, charge, origin, etc.

Reports can be sent to carriers by clicking on the Email button in the top 
toolbar across the top of Magaya Explorer.

• Create Standard Rate: Use this to create a selling rate based on the rates 
your carrier gives you.

Select a rate in the list and click on this option. A dialog box opens. Select 
a markup type (percent or flat) and enter an optional markup value (how 
much you will add to the price). For discounts, enter a minus sign and the 
number. Click the OK button. The Rate dialog box opens. Verify the rate 
and click OK.
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• Create a Customer Rate: Use this to create an individual rate to apply to 
one specific customer. Click on a rate in the list and select this option. A 
dialog box opens.

Select the markup type (percent or flat), enter the markup value 
(optional), and select the customer this rate applies to. Click the OK 
button. The Rate dialog box opens, showing you the amount the system 
just calculated. Verify the rate and click OK. For discounts, enter a minus 
sign and the number in the Markup Value field.

• Modify Rates: Use this to change rates. See details in the section “Modify 
Rates for Your Customers”.

• Query Rates: Use this to perform a query on carrier rates. Enter the infor-
mation you need for the query in the dialog box that opens. See details on 
how to use this screen in the topic “Query Rates:”

http://knowledge.magaya.com/#/article/query_rates

• Choose Columns: Rearrange, add, or remove columns from the list view.

• Import or Export data in XML or CSV formats in or out of your Magaya 
database. See the following article for details:

http://knowledge.magaya.com/#/article/import_rates
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Query Rates

How to Query Rates

Use the “Query Rates” button to open the query screen when you need to look 
up rates for carriers or to query selling rates. The button can be found on the 
Rates dialog box for Standard Client Rates and Client Rates. The query dialog 
box is also available from the Actions button in Quotations and in the Rates 
folder for Carrier Rates, Standard Rates, and Client Rates.

To query carrier rates, go to the Carrier Rates folder. To query selling rates, go 
to the Client Rates folder or the Standard Rates folder. The fields in the Selling 
Rates query dialog box are the same as in the Query Carrier Rates dialog box.

When the Query Rates dialog box is opened from the Actions button, it can 
remain open while you move to other screens in your Magaya system. When 
you close the screen, the information you entered will remain available to reuse 
or change.
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Add multiple types of freight service class by clicking the button with the three 
dots that is next to the Freight Service Class dropdown. In the dialog box, check 
the types to include in the query.

The date field canbe used to query future rates.

If you want to query other rates or charges such as documentation, you can add 
them to the query by using the “Select” button for “Other Charges” and see all 
the rates. The query of other charges pulls from the information in your 
Accounting folder in your Magaya system.

Select the origin and destination information and method (mode) of transport. 
These fields are required.
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Enter as much information about the cargo as needed.

Click “Find” to generate a list of rates that match the criteria you enter.

The best rate will be checkmarked in the results list. You can add columns to the 
list by right-clicking on a result. In the “Choose Columns” dialog box, click the 
“Add Columns” button to access more choices such as the Transit Time under 
Rates.

Create a Quotation from the Query:

To create a Quotation from the selling rate dialog box, click the “Create Quota-
tion” button.

When creating a Quote from the Carriers Query rate screen, you can specify if 
you want to include the expense charge in the quote’s Charges. You also have 
the option to choose to summarize the income charges in an “All in One” 
charge. This will add whatever fee you select in the dropdown.
52



Query Rates Chapter 2
The Quotation dialog box will open with all the rate query information filled in 
automatically. Make any changes or add information in the dialog box to create 
the document. Email or print the document.
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Standard Client Rates

Standard Client Rates are the rates you charge all your customers.

Steps to Set Up Standard Client Rates

To set up Standard Client Rates:

1) Go to the Rates folder and click “Standard Client Rates”.

2) Click the Add button and select Single or Multiple Rates from the pop-up 
menu:
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This example shows you how to enter a single rate. For details on Multiple 
Rates, see the section “Client Contracts.” When you use the “Single Rate” 
option, the system will create one rate for a service such as priority freight or a 
fuel surcharge that will apply for all customers who send freight to the origin 
and destination you assign in the Rate dialog box. Let’s look at the Rate dialog 
box.

A dialog box opens with three tabs:

• On the General tab, select the Freight Service Class from the dropdown 
menu such as “Air Freight Service”.

• Enter a description (optional). Use this for Commodities that you want to 
classify by type such as electronics. To enter a new commodity, click on 
the plus sign in the dropdown menu, enter the information and click OK. 
Commodity Types can also be entered in Maintenance > Configuration > 
Commodity Types. The Commodity Type can also be specified when you 
are entering Inventory Item Definitions: Select the Commodity field on 
the General tab.

• Select the origin and destination cities for this rate.
 55



Chapter 2 Standard Client Rates
• Select the method (mode of transportation) such as Air.

• Transit Time: Enter the number of days of the voyage. (This information 
can be added to the Query Rates screen.)

• Select how you will apply the rate: by the piece, by weight, volume, 
container, or by a calculated rate. When you make this selection, the drop-
down menu next to it will change depending on what you select. You can 
set the units for weight such as pounds and for volume such as cubic feet. 
For more details, see the section on “Tariffs”.

• Use Gross Weight instead of Volumetric Weight in air and ground rates. 
(Previous versions of Magaya software before v8.5 required a formula for 
this.)

• Enter a minimum and/or a maximum rate as needed.

• Click the Add button to add a rate. This will activate the next line in the 
rate table. Click on the table cell under “More than” and “Rate” to edit the 
table cells. The example shows the first table cell with a rate of 2.50 for one 
pound or more. The next table cell shows 2.00 for weight over 100 pounds.

• To query a rate, click on the “Query Carrier Rates” button. This will query 
previously created Carrier Rates. This is useful when you are creating your 
standard client rate; you can look up your purchasing rates for compar-
ison. See the section “Query Rates” for details.

If you have a contract with the client, click on the Contract tab in the Rate dialog 
box and enter the dates and contract number.

If you want to add any notes, click on the Notes tab and enter them.

Click the OK button when done.

Result: The rate now displays in the list and is available to use in shipments.
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Actions in the Standard Client Rates List

Click on the Actions button to access the following options:

• Reports: Create a report of all Standard Client Rates

• Other Reports: Create reports by description, charge, destination, etc.

Reports can be sent to customers by clicking on the Email button in the 
top toolbar across the top of Magaya Explorer.

• To create a Customer Rate, click on a rate in the list and select the option 
“Create Customer Rate” from the Actions button. This sets a rate that 
applies to one customer. A dialog box opens:

Select the markup type (percent or flat), enter the markup value, and select 
the customer that this rate applies to. Click the OK button. The Rate dialog 
box opens. Verify the rate and click OK. This will apply the markup to that 
one customer.

• Modify Rates: Use this to change rates. See details in the section “Modify 
Rates for Your Customers”. The rate modification will apply to all clients. 
If you want to modify a rate for only one client, use the Actions button in 
Client Rates.
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• Query Rates: See the topic “Query Rates” for details:

http://knowledge.magaya.com/#/article/query_rates

• Choose Columns: Use this to rearrange columns and add or delete 
columns in the rates list.

• Import or Export data in XML or CSV formats in and out of your Magaya 
database.

Rates can be added individually or in bulk. To import rates in bulk into 
your system, use a CSV or XML file. For steps, see the topic “Import Rates” 
in the Knowledgebase:

http://knowledge.magaya.com/#/article/import_rates
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Custom Rates

Create Customized Rates

You can customize a rate for a client by using a wizard or by opening the Rates 
dialog box in the Customer’s profile. The rate can be based on the standard one 
created for all customers and then changed for a specific customer. This custom 
rate will override any standard rate you set up in your Magaya system for that 
customer.

The wizard is available from two places in Magaya Explorer: Right-click on the 
customer name in the Customer List and select “Rates” from the pop-up menu. 
In the list that opens, click on the Add button to use the wizard.

You can also access the wizard by selecting “Client Rates” under the Rates 
folder:

For details on using the wizard, see the topic “Modify Rates for Your 
Customers:”

http://knowledge.magaya.com/#/article/amend_rates

The following example shows you how to customize a rate by using the Rates 
dialog box in the Customer’s profile:

1) Go to the Maintenance folder.

2) Click on Customers.
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3) In the Customer profile dialog box, click on the Rates tab.
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4) Click on the Add button in the Rates tab. A dialog box opens.

• On the General tab, select the carrier.

• Select the freight class service. This pulls from the Items and Services 
of type “Freight” and “Other Freight”.

• Enter a description (optional). Use this for Commodities that you 
want to classify by type such as electronics. To enter a new 
commodity, click on the plus sign in the dropdown menu, enter the 
information and click OK. Commodity Types can also be entered in 
Maintenance > Configuration > Commodity Types. The 
Commodity Type can also be specified when you are entering Inven-
tory Item Definitions: Select the Commodity field on the General 
tab.

• Select the origin and destination cities for this rate (from the ports 
list).
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• Select the method (mode of transportation) such as “Vessel, 
Containerized”.

• Transit Time: Enter the number of days of the voyage. (This infor-
mation can be added to the Query Rates screen.)

• Select how you will apply the rate. The screen will change depending 
on what you select.

• Click the Add button to add a rate. This will activate a line in the 
Prices table. Enter information for each in the fields such as weight 
and rate. For example, you can charge by weight to calculate the 
prices. If cargo weighs more 50 pounds, type on 50 and the rate. Add 
the next one as 100 pounds and the rate. You can add as many as you 
need. This rate shows a container, the type of container and its rate. 
See the section on “Tariffs” for more details on using this table.

5) Click on the Contracts tab if you have a contract number and expiration 
date.

6) Click on the Notes tab to enter any notes as needed.

7) Click the OK button to save settings when you are done.

Result: This customized rate is now ready to be used. Your customers with 
access to Magaya LiveTrack can view the rates online.
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Amend Rates

Learn how to make changes to rates in your Magaya system when you get a rate 
increase from a carrier. Also learn how to change a rate per customer.

This article explains how to modify existing rates by using the wizard explained 
below. You can overwrite existing rates by just importing new ones via the 
Import Wizard. The wizard will expire old rates and add new ones. See the 
Knowledgebase article about the import wizard for more:

http://knowledge.magaya.com/#/article/import_wizard_tips

Amend Rates based on GRI

When you receive a General Rate Increase (GRI) from a carrier, you can enter 
the updates in your Magaya system and apply the rate increase to multiple ports 
at one time, instead of one at a time.

Make sure you select the correct amendment that you want to make changes to.

1) In the Amendments screen, click the plus sign. A dialog box opens.

2) Enter the Amendment Number and Effective Date.

3) Click OK. The dialog box closes, and the new amendment appears in the 
Amendments list. It will show the contract number and the amendment 
number.
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4) Select the new Amendment to highlight it.

5) Go to the Rates section of the screen and click on the plus sign. Be sure you 
are in the correct amendment before you start to add new rates.

This example illustrates how to enter a 10% rate increase for a group of 
ports that have increased by the same amount.

6) From the Add button pop-up menu in the Rates section, select “Multiple 
Rates”.

7) In the wizard, select "Copy from entities rates" for this carrier. If you want 
to use another carrier, select it from the dropdown “Select source entity”. 
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In the additional fields that appear, enter the details of the transformed 
rates (such as percent and value of 10).
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8) Click Next. The Filter screen will appear. Here you can specify exactly 
which rates you want to transform. Filter the rates to find the rates that 
you want to apply the change to by specifying the following:

When you set these criteria, the system will search in your Magaya data-
base for any rates that match these criteria and already exist. If you leave a 
field blank in this screen, the system will apply the transformation to the 
criteria in that field.
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9) Make changes such as removing ports that you do not want to apply the 
new rate to, and click the Next button.
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10) In the next screen, “Found rates” the system will display the rates for the 
ports you selected. Click the Next button.

11) The system generates the new rates, applying the 10% increase to them all 
for you. It will split rates if you have two container sizes (20- and 40-foot) 
in the existing rate. For example, if you get an increase for a 20-foot 
container but not for a 40-foot container, the system will split the rates and 
show them all to you in this screen. Review the information and click 
Next.

12) The system will show you the rates that will be expired and replaced with 
the new ones you just added. The old rate will expire right before the new 
one takes effect. Review the date and time information and click Next.
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13) Click Save.

When you click the Save button, the system tells you the processing is 
completed.

If you want to add additional rates that use some information that is 
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similar to the rates you just entered, then click the Restart button.

If you click on the Restart button, the wizard will return to the first screen 
and show all your information on each screen so you can make changes.

14) Click Finish. The wizard closes, and the new rates are displayed in the list.

Modify a Standard Rate

When carriers raise their rates, you update the GRI and then apply the increase 
to your customers. If you do not want all your customers to have the same 
increase, you can give a customer a discount.

For this example, let’s say you already entered the GRI and applied it to all the 
customers via the Standard Client Rates. To give a customer a discount, follow 
these steps:

1) Go to Client Contracts.

2) Add a new amendment for the customer.
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3) Use the Multiple Rates wizard: click the option to “Transform from 
existing standard client rates”. Enter the amount of the change (for 
example, by weight and by percent). For this example, let’s modify the 
ocean freight for our customer, Jamaica Distribution Center, and only 
raise it by 20% instead of 30%.

a. For the field “Transformation Type,” select “Decrease a percentage”.

b. For the field “Value,” enter 10.

c. Specify the conditions such as “Ocean Freight Service Cost” and “Vessel, 
Containerized”, etc. according to the GRI.

4) Complete the wizard by specifying ports, reviewing the rates generated by 
the wizard, and save the changes.

The discounted rate for that customer is saved. When a shipment is 
created for this customer, the system pulls the rate from this discounted 
rate.

For a PDF of this procedure, see the Magaya.com Training page, Tech Tip 
for June 2012.
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Modify Rates for Your Customers

To make a change to the rate you charge your customers, follow these steps.

1) Go to Client Rates > click on the Actions button > select Modify Rates. A 
wizard opens. In the first screen of the wizard, do the following:

1. Select the client (customer) that you want to change the rate for.

2. Choose the type of modification: a) To change the expiration date, or b) 
to modify the rates. If you are modifying the rates for the customer, select 
how you to modify them - what type and the value.

2) Filter the rates in the next screen by service class, method of transport, and 
other criteria that apply. Click the Next button.

3) Select the ports from the list and go to the next screen to see the rates the 
system found.

4) In the last screen click the Save button to save and finish the wizard. If you 
want to make other changes with similar criteria, click on the Restart 
button.
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Note: This wizard works the same for Carrier Rates and for Client Rates.

When you customize the Standard Client Rates, the first screen in the wizard 
does not have a client to select because the modification you make will apply to 
all clients.
73



Chapter 2 Carrier Contracts
Carrier Contracts

Managing Contracts

When you get a contract from a carrier or you want to create a contract with a 
customer, you can enter the rates for those contracts in your Magaya system and 
update them in groups.

Then the rates are available to use in shipments and other transactions, saving 
time since they do not need to be entered each time.

The contracts feature is an easy way to create rates and group them in your 
Magaya system. You can find the contracts in the Accounting folder:

The Carrier Contracts is the place in the Magaya system that handles your 
purchasing rates (your cost to purchase carrier services). This is where you enter 
the rates that the carrier gives you.
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The Client Contracts are used to handle the client rates, which are used to 
calculate the selling prices.
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Add a New Carrier Contract

When you get a new contract from a carrier for the first time, use this method 
to enter the contract into your Magaya system. After you enter the contract 
details, then enter the rate information for that carrier.

1) Go to the Accounting folder.

2) Expand the Rates subfolder and select “Carrier Contracts”. The screen has 
three sections: Contracts, Amendments, and Rates:

3) Start in the Contracts section: click on the Plus sign. In the dialog box that 
opens, enter the following:

• The contract number.
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• The date the contract will become effective.

• The date the contract will expire (the default is one year from today).

• Select the carrier.

• Select the contact - the person who is your contact person. Click on 
the dropdown to access the Contacts list and make your selection. 
This field is optional.

• The Employee is the person who is adding the contract into the 
system. This will be filled in by the system.

• The Division is optional.

To include a copy of the contract as an Attachment here, scan it and attach 
by clicking on the Attachments tab and clicking on the Add button. 
Details on attaching via a scanner are explained in the Magaya Cargo 
System Operations Manual.

Add any notes as needed on the Notes tab.

4) Click OK.

The contract is added in the list.

When a new contract is added into the system, the system will create a default 
amendment called "Initial" and place it in the Amendments list.

To view the original amendment, double-click on “Initial” in the Amendments 
list to open the dialog box.
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The Number field is "Initial". This Initial amendment is the original contract, 
with the same effective date as the original contract and all the details.

Now that the carrier contract information is entered in your Magaya system, 
you can enter the rates for this contract.
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Add Rates to a Carrier Contract

After you add a contract into your Magaya system, select it to add rates to it.

1) In the Rates section, click on arrow on the Plus sign and select from the 
pop-up menu:

Use the “Multiple Rates” option to create carrier rates in batches for many 
ports of origin and destination.

Use the “Single Rate” option to open the rates dialog box to enter one rate 
for one origin/destination. This is explained in the section “Set Up Carrier 
Rates”.

The following example explains how to enter multiple rates.
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The wizard that opens contains the following fields:

The carrier name and Effective Date are filled in the first screen of the 
wizard based on the contract you are working on. These fields are 
Read-Only. To edit them, go to the Contract itself. You can add an expi-
ration date.

2) Select how you want to create rates:

• Enter your own rates: With this option, you enter the rates and the 
origin and destination from the contract, and the system will create 
the rates for you for all the origins and destinations you enter. For 
example, if a carrier sends you one rate for a 20-foot container for a 
group of ports, use this option.

• Copy from similar entities rates: Use this option to make amend-
ments, for example by origin and destination or by percentage. (This 
option is shown in the section “Amend Rates based on GRI”.) The 
advantage of this option is you will not have to recreate the rates 
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from scratch; it works with the existing data you have previously 
entered for this carrier.

When this option is selected, another field appears for you to enter 
the details: Select the type of modification (by percentage or flat rate 
increase or decrease), and enter the value (the number such as 10 for 
10%).

3) Click the Next button in the wizard to go to the next screen. Select the 
ports by clicking on the Add button to open the Ports list. Click on the 
port names and click the OK button. Do this for origin and destination 
ports:
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4) Click Next to go to the Common Rates screen. In this screen, click on the 
Add button to open the Rates dialog box.

• Select the Freight Service Class. This example shows Priority Freight 
Service Cost.

• The Description/Commodity is optional.

• Select a Method of transportation for this rate.

• Select how you want to apply this rate, for example by weight (in 
pounds). Click on the dropdowns for other options.

• Transit Time: Enter the number of days of the voyage. (This infor-
mation can be added to the Query Rates screen.)

• Enter a Minimum and Maximum amount (optional).

• Select a rate by unit or range. Rates per range are useful for Roll On 
Roll Off (RORO) rates. To set a RORO rate, apply the rate by volume 
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(cubic feet) and click Rate per Range. Then enter the ranges such as 
1 to 30 cubic feet, then 31 to 50 cubic feet, etc

• Click on the Add button to enter rates amount per weights.

• Click the OK button to save the rate information.

5) Click Next. The system will generate rates for each port based on the infor-
mation you entered and display the results:

If you want to make an exception for one of the ports shown, select it and 
click “Edit”. To exclude that port from this rate, select the line and click 
“Remove”.

6) Click Next. The system will show you the rates that will be expired and 
replaced with the new ones you just added. If you do not have similar 
rates, this screen will be blank. To exclude a rate from expiring, select it 
and click “Remove”. Otherwise the system will expire any listed in this 
screen as of the day before the effective date for the new rate.
 83



Chapter 2 Carrier Contracts
7) Click Next to go to the last screen in the wizard. Here you can save and 
finish, or save and add another rate:

• Click Save: The system tells you the processing is completed.
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• Or click Restart: If you want to add additional rates that use some 
information that is similar to the rates you just entered, click the 
Restart button.

By clicking Restart, the wizard will return to the screen with the 
origin and destination ports.

8) Click Finish. The wizard closes, and the new rates are displayed in the list.

Extra Info: The same expiration rate can be used when copying a rate. This is 
useful when creating sales rates from the cost rates.

If a carrier offers a discount, you can use a negative number.
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Client Contracts

Magaya software includes a wizard to help manage contracts you offer your 
customers.

Client Contracts: Add Contracts and Rates

Use the wizard screens to manage contracts you create for your clients. The 
wizard works the same way as the wizard for adding carrier contracts and 
carrier rates.

First, add the contract for the client.

The contract for the client is added. Now you can add rates for that client.
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Select the amendment and click on the Add button in the “Rates for Amend-
ment” part of the Client Contracts screen. A wizard opens. This example shows 
you how to enter your own Multiple Rates.

1) Enter the information in the first screen of the wizard for this client:

• Enter your own rates: With this option, you enter the rates from the 
contract, the origin and destination, and the system will create the 
rates for you for all the origins and destinations. For example, if a 
carrier sends you the same rate for a 20-foot container for a group of 
ports, use this option. This example will show this option.

• Copy from similar entities rates: Use this option to make amend-
ments, for example by origin and destination or by percentage. You 
will not have to recreate the rates from scratch. It works with the 
existing data you have previously entered. When this option is 
selected, another field appears for you to enter the details: Select the 
type of modification (by percentage or flat rate increase or decrease), 
and enter the value (the number such as 10 for 10%).

Select source entity: Use a similar rate that you created for a different 
customer.

• Copy from carrier rates: Select the carrier that you want to use that 
has similar rates so you can copy those rates here and make changes.
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• Copy from standard client rates: This will use the Standard Client 
Rates you set up earlier. Then you can make changes to the standard 
rates.

2) Click Next to select the ports. (You will see the filter screen if you are 
transforming from existing rates.)

• Click the Add button to open the Ports list. Click on the port names 
and click the OK button. Do this for the origin and destination. Click 
Next to go to the next screen in the wizard.

3) Click the Add button to enter the common rates for the ports you selected 
in the previous screen.

4) Click Next to go to the next screen. This screen will show you the rates that 
were generated by the system. You can edit a rate here if needed. Click 
Next.

5) If there are any rates similar to the ones created, the system will set the 
expiration dates for them based on the effective date. Click Next.

6) Click the Save button if you are done.

The rate information is saved. The following note will appear: “The 
process has finished successfully.” Click the Finish button if you are done.

7) Click on the Restart button if you want to add more rates and use some of 
the same information. The wizard will return to the first screen and show 
all your information on each screen so you can make changes.
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Salesperson’s Commissions

Introduction to Commissions for Sales

In your Magaya system, you can add salesperson’s profiles and include commis-
sion participation rates for each salesperson when they sell or freight or inven-
tory. The system enables you to enter profiles for sales people who are 
employees or outside contractors/vendors:

• If a salesperson is an outside vendor, enter their details in the Salesperson 
profile.

• If a salesperson is an employee, enter their details in the Employee profile 
and a Salesperson profile. The Employee profile includes the User login 
and password fields.

Commissions can be set individually for each salesperson or system-wide to 
apply to all sales people. To set a percent commission system-wide to apply to 
all salespeople for liquidations of shipments, go to Maintenance > Configura-
tion > Accounting and click “Configure Liquidation Options” button for 
Outgoing or Incoming. Set the percent in the dialog box.

This article explains how to add a new salesperson to your Magaya system, set 
their commission for freight and for inventory items, how to see a report of 
commissions, and how to activate LiveTrack access for a salesperson so they can 
place orders online for their customer using LiveTrack.

Add a New Salesperson

To add a new salesperson to your system, follow these steps:

1) Go to Maintenance > Salespersons.

2) Click the Add button.

In the dialog box that opens, you can enter details on any tab. On the 
General tab, enter their email, phone number, which division they work 
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for if applicable, their address, billing address if different, and other 
personal information as needed.

The Identification number can be a DUNS, EIN, SSN (Social Security 
Number), a Foreign or Other type of number.

Freight Commission

Individual sales people can have their commissions calculated in Magaya 
Explorer for any freight they sell. Set the commission amount in their profile, 
and the amount will be automatically added to transactions such as shipments.

To add a freight commission (“participation”) for a salesperson, open their 
profile in Maintenance > Salespersons.
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Click the Participation tab and perform the following steps:

1) Click the “Add” button and select “Freight Participation”.

Note: The freight and inventory options are available in the Magaya 
Supply Chain Solution and Magaya Distribution System.

2) In the “Participation per Customer” screen, select a customer to associate 
with the commission. This means each transaction that includes this 
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customer will generate a commission for this salesperson based on the 
amount set here.

3) Click the “Add” button. Select either a charge or a shipment.

An example of a Charge is “Ground Freight Service”.

To choose how you want to calculate the commission, click the “Type” 
dropdown and choose the type of commission. This example shows 
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percentage of profit, but you can also select a flat rate, or set the amount 
to calculate by volume, weight, or pieces).

Enter the value such as “5” for five percent of the profit.

An example of a shipment is a percent of a type of shipment such as an 
ocean export. Percents can be set individually per type of shipment.

Click OK in each dialog box to save.

When a salesperson sells freight, the commission is generated in the shipment 
transaction in the Liquidation screen.

View Columns for Participation:

Click the “Actions” button to see the list of columns you can add to the Liqui-
dation screen. Select the columns for the salesman name, participation, and 
profit.
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The commission can also be changed in the Liquidation screen by 
double-clicking on the line.

When you click the “Generate” button in the Liquidation screen, a dialog box 
opens listing all the accounting transactions for the shipment, including the Bill 
for the salesperson’s commission.

The bill and other transactions are saved in the Magaya accounting folder.

To see how the commissions are generated in shipments, see the topic “Liqui-
dation” in the Knowledgebase:

http://knowledge.magaya.com/#/article/liquidation

When a salesperson has participation in the profit in a shipment, the sales-
person can view the shipment in LiveTrack. This applies to the Magaya Cargo 
System.

Inventory Commissions

In the Magaya Commerce System and Magaya Supply Chain Solution, salesper-
sons commissions for inventory sales can be set per item, per category, or 
system-wide.

Configure General Inventory Commissions System-wide:
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To configure a general commission that applies to all inventory sales and to all 
salespersons system-wide, follow these steps.

1) Go to Maintenance > Configuration > Sales

2) Click the “Commissions” button.

In the dialog box, select the Type and Value of the inventory commission. 
This will be applied to all inventory items sold by any sales person. For 
example, to add a commission of 5% of the profit, enter “5”. (Do not type 
in “0.05” for 5%. Type “5”. Do not type the percent symbol in the field.)

3) Click OK and Save.

Inventory Commission per Item:

To add a commission to an item, you can add it from the Salesperson profile or 
go to the Inventory Items Definitions list, open (or create) an item.

On the Accounting tab, click the “Commissions” button.
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A dialog box opens (it’s the same dialog box regardless if you access it from the 
salesperson’s profile or from the Inventory Item Definition). Select the type and 
set the value for the commission in the dialog box.

Choose from Flat Value, Percentage of Profit, Percentage of Income, or a Calcu-
lated Amount. If you want to create the commission to be based on income of 
the charge, you can do it regardless of the cost. As a result, the company does 
not disclose the profit made.

Inventory Commission per Category:

To add a commission to a whole category of items that are sold online in the 
Online Sales Orders of Magaya LiveTrack, (for users of the Magaya Supply 
Chain Solution), go to the Inventory Organizer in the Warehousing folder.
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Open (or create) a category, and select the type and set the value for the commis-
sion in the dialog box.

When a customer purchases an item online, the commission amount is added 
to the transaction.
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When a salesperson sells inventory, the commission can be generated from the 
Sales Order by clicking on the Actions button (after creating the Invoice). The 
system creates a Bill payable to the salesperson.

Reports

Reports can be created in your Magaya system to view all commissions:
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In the Salesperson’s List or Agent’s, go to: Actions > Reports

Additional reports are available from the Reports menu on the top toolbar of 
your Magaya Explorer. Select “Profit Reports” to see profit by salesperson or 
agent.

The “Sales Reports” menu option also includes other accounting reports that 
show commissions such as the “Sales Reports by Item” report. Also see the 
Chart of Accounts to make a report from the Actions button to see accounts by 
Type Code (the commissions are grouped under Expenses).
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Enable a Salesperson to Submit Orders on behalf of Customers

To give a sales person at your company the ability to place orders for their 
customers, such as when visiting with them, follow these steps:

In Magaya Explorer:

First, add the salesperson, or edit an existing salesperson’s profile.

Next, right-click the salesperson’s name in the list. From the pop-up menu, 
choose “Allow Tracking.”

Create (or click Autogenerate) a password (passwords: minimum 6 characters. 
usernames: 6-15 characters). Ensure the box is checked to enable LiveTrack 
access.

On the Tracking tab, check the permissions to activate. The permission to view 
sales orders is on by default.

Click OK save.

To view the list of salespersons who have LiveTrack access, choose the column 
“LiveTrack User” from the Actions button.

In LiveTrack:

In LiveTrack, the salesperson logs in and clicks the “Add” button in the Sales 
Orders screen to place a new sales order. The Buyer field displays the sales-
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person’s name. (It can be changed if needed to click the arrow to select the 
customer name from the dropdown. These entities shown in the list are related, 
i.e., the salesperson has created another transaction for them previously.)

In step 2, the salesperson can search for items, can type in the quantity, or can 
upload a file into LiveTrack. To upload a list, click the “Upload” button. Use a 
CSV or text file with 2 columns: Part Number and the Quantity. If format is an 
Excel spreadsheet, it must be saved as CSV. Don't leave the Quantity field blank; 
add zero if unknown. If the Magaya database doesn't have the item defined 
already, it will upload it from the import file.

Complete the online sales order as usual. See the Knowledgebase article for 
steps:

How to Place Sales Orders Online in LiveTrack

http://knowledge.magaya.com/#/article/customers_place_sales_orders

When the sales order arrives in your Magaya system, go to the Sales Order list, 
right-click it to make a Cargo Release.

If a Cargo Release or Shipment is loaded with items from a Sales Order that was 
assigned to the salesperson, then the salesperson will be able to track that status 
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of those releases and shipments in LiveTrack (Magaya Distribution System or 
Supply Chain Solution required).

Related Resources

You can also set agent participation in your Magaya system. See the following 
Knowledgebase article:

http://knowledge.magaya.com/#/article/agent_participation
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Agent Participation

Introduction to Agent Participation

This topic shows you have to set up the participation amount for agents you 
work with such as destination agents. The software gives the option to define a 
rate that applies to all agents in your Magaya system, or to set the rate per agent 
based on specific charges and in shipment transactions.

Configure Agent Participation System-wide

The Magaya system enables you to set agent participation system-wide or per 
agent. This section shows you how to configure your Magaya system to apply a 
setting to all agents.

1) Go Maintenance > Configuration > Accounting

2) Click the button for Outgoing or Incoming for “Configure liquidation 
options.” You can set the percent for each type of shipment inde-
pendently.

3) Check the box for the agent shipment participation and enter the percent

Note: This is the same configuration dialog box available in the Liquida-
tion screen of a shipment.

Result: The system will process the configuration automatically when a 
shipment is created. Changes can be made per line of the shipment liqui-
dation screen if needed.
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Set Agent Participation for Charges and Shipments

Entering data in your Magaya system for agent participation is similar to setting 
salesperson’s commissions. Let’s look at the agent’s profile to see how to set 
their participation for charges and for shipments:

1) Go to Maintenance > Forwarding Agents.

2) Open the Agent’s profile. In the dialog box, go to the Participation tab.

Click the “Add” button and select the type of participation you want: 
Charge or Shipment.
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• In the Charge Participation dialog box, select the Charge, Type, and 
Value. The Type can be a percent or profit or income, a flat value, or 
amount per volume, weight or pieces.

If you select Percentage of Income, then you will see the symbols 
“%I” after the number when you liquidate the shipment (in the Ship-
ment Liquidation screen).
105



Agent Participation Chapter 2
• In the Shipment Participation dialog box, add the value. The Type 
is percent of the shipment profit. Check the boxes for the modes of 
transport for this percent.

The system calculates the shipment participation for a charge partic-
ipation, if one is set.

3) Click OK on each dialog box to save.

Related Resources

To see how the agent’s participation is generated in shipments, see the topic 
“Liquidation” in the Knowledgebase:

http://knowledge.magaya.com/#/article/liquidation

To learn how to set a sales person’s commission and how to create reports, see 
the following article in the Knowledgebase:

http://knowledge.magaya.com/#/article/sales_commissions
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Introduction to the Configuration Menu

You can customize your Magaya software in many ways. The Configuration 
menu in the Maintenance folder provides options to:

• Set up measurement units and how much detail to display in your docu-
ments

• Set up document numbering for checks, invoices, pickup orders and other 
transactions

• Enter clauses and define events to use in shipments and other transactions 
specific to your company

• Set up Transaction Tracking and customize the email invitation

• Create custom fields to use in transactions and forms

• Define Task Types and more

Some options may not be available in your system, depending on the software 
program you are using or if a plug-in is activated for your Magaya account. To 
activate an option, contact your Magaya Logistics Advisor.

To access the Configuration menu, go to the Maintenance folder:
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The Configuration menu appears in the viewing pane of your Magaya Explorer. 
To see all the options, use the scroll bar.

You can also open the Configuration menu by clicking on “Options” from the 
top of your Magaya Explorer screen.

Click the Save button at the bottom to save any changes. If you want to return 
to your previous settings, click the Reset button. Any changes made to the 
configuration menu options are recorded in the Transaction Log.

The following sections explain each configuration option in detail.
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General

The “General” option contains the following choices:

• Create Events Automatically: This box is checked by default. This will 
turn on or off the capability to add events automatically to the operations 
transactions. To define events for use in your system, go to the Event Defi-
nition option in the Configuration menu. Events will display in the Events 
tab of related transactions.

• Common options to this computer: This enables the following customi-
zations that can be set per computer:

– Fill lists in reverse order: This box is checked by default. This will 
display lists such as the Warehouse Receipts (WR) List or Pickup 
Orders List with the most recent transaction at the top. Unchecking 
this box will show the oldest transactions at the top.

– Limit the quantity of shown items per list to: Set the number as 
needed. This is useful when your database grows and you do not 
need to view older transactions.

– Working Date Period: These options allow you to choose between 
setting the working date period by dates you specify or by an auto-
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matic number of days. When you have a database with several years 
of data, you can set a Working Date Period to view only the data 
from the current year.

Note about how settings apply per computer: If you log into another computer, 
you will see the settings for that computer. This is not the same as per user.

Click the Save button (or Reset button).

Company

This option will set the type of company you have. This can also be set in the 
Startup Wizard. If you used the Startup Wizard, the type of company you 
selected will appear here. If not, it will be blank. You can select a choice in this 
screen at any time.

If more than one of the options apply to your company, select all that apply.

• If your company is a logistics provider, check the first box.

• If your company is an airline carrier, click on the Airline Carrier button. 
This enables you to assign Air Waybill numbers to customers (this will be 
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available under the Maintenance folder). This will treat Masters as Flights, 
and Houses as Masters.

The option below “Airline Carrier” will be activated when you check the 
Airline Carrier button. You have the option of generating numbers for 
house shipments when you create consolidations. By checking the box, the 
numbers will be created. Do not check the box if you do not want the 
numbers generated.

• If your company is an Ocean Carrier, select this button to allow different 
ports of loading and unloading per voyage. With this option, Masters are 
treated as Voyages, and Houses are Masters.

• If your company has a bonded warehouse, check the box. Result: This 
selecting will activate fields on the General tab in the Warehouse Receipt's 
dialog box for the Entry Number, Type and Date.

Upload your logo to use in documents and LiveTrack. See how to upload the 
logo and add it to templates:

http://knowledge.magaya.com/#/article/add_image_logo

Click the Save or Reset button.
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Document Numbers

Document numbers for operations transactions can be customized in your 
Magaya system by using this screen:

The Magaya system is set to number all transactions with consecutive numbers. 
If you want to change this default, uncheck the box for the transaction you want 
to use non-consecutive numbers for. If you uncheck a box, the Set button is 
grayed out (inactive).

As a result of unchecking the consecutive numbering setup, each transaction 
made will require the user manually enter a transaction number.
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If you uncheck the box “Use shipment numbers”, the message below it will 
change to “Shipment numbers will not be used”:

For Exports, activate the numbering formatting for Air, Ocean, and Ground 
transactions by checking the box for Export Masters or Straights. The buttons 
with the three dots will be activated. Click on a button to open the number 
formatting dialog box. (Note: This button opens the same Document 
Numbering dialog box as the Set button.)

For Imports, you can make the Import shipment numbers different from the 
Exports by checking the box “Different from export.” The Set button will be 
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activated and the message changes to “One number for Consolidations and 
Straight shipments. House shipments have their own numbers.”

The Document Numbering dialog box has the following options:

Numbers can be formatted as follows:

• Prefix: This will add numbers or letters to the front of the transaction type 
you have clicked the Set button for. For example, if you want all your 
Warehouse Receipts to begin with the letters “WR”, enter the letters WR 
in the Prefix field. Other examples: The House Air waybill document 
numbering has a default prefix of “HAWB”. The Ocean and Ground 
formats begin with “HBOL”. This can be changed by typing over the 
default letters.

• Suffix: This will add numbers or letters to the end of any transaction 
number.
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• Start number at: Enter a number here to start the numbering of docu-
ments. The first document you create will use the next number. Example: 
If you enter 0, then next document will start with 1.

• Do not allow duplicated numbers: Check this box to avoid having any 
documents with the same number. If you do not check this box, the system 
will ask you if you want to use the same number when you are creating this 
type of document. You can choose Yes or No at that time.

• Lock transaction numbers: Some documents have the option to allow 
you to lock the transaction numbers such as Air Waybills or Bills of 
Lading. Setting this requires admin rights. This option is off by default. 
Click the box to activate it.

• Click the OK button to save changes and return to the screen.

Click the Save or Reset button in the screen.

Accounting

The choices in this configuration screen set up accounting document features 
such as:

• Using consecutive numbers in accounting documents

• Managing landed costs and average cost of inventory

• QuickBooks exporting configuration

• How your system manages Credit Limits for customers

• Other settings: To generate charges automatically, date to close 
accounting, transaction due dates, set currencies, set fiscal year, set up 
default accounts, set periodic invoicing, setting sales tax, and set liquida-
tion options

This option is explained in the topic “Advanced Accounting Features” in the 
Magaya Software Accounting Manual. See the same topic in the Knowledgebase:

http://knowledge.magaya.com/?search=Configure_accounting
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Automatic Charge Generation

This configuration enables your system to include charges automatically on 
transactions.

This configuration is checkmarked as Enabled by default. It uses the current 
date to generate charges. Change as needed. .

Tell the system if you want to use the current date or transaction departure date 
for the charge generation.

This menu also has a feature for use with the Routes feature to enable your 
system to generate charges based on the time offset between the route segment 
and the generation date.

When creating a quote from the Query Rates screen, this checkbox will tell your 
system to automatically update the charge (see the Charge dialog box) on the 
Quote transaction. For example, if you make a change to a commodity such as 
the weight, the charge for the new weight will be calculated and updated auto-
matically.

This screen works in combination with the Automatic Creation tab on the Items 
& Services dialog box. See Chapter 2 in the Magaya Software Customization 
Manual to learn how to automate charges, or learn more in this Knowledgebase 
article:

http://knowledge.magaya.com/#/article/intro_automated_accounting
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Fiscal Printer

This configuration option is used to set up a fiscal printer to print invoices and 
credit memos. Fiscal printers are mandatory for Latin American accounting 
transactions.

Mote: If you need to configure another printer such as printing labels, see the 
section “Labels.”

To activate the fiscal printer feature after you install the fiscal printer, check the 
box in the Configuration screen to enable the feature:

In the field “Company commercial name” enter your company’s name as you 
want it to appear on the documents you print. This is a general system-wide 
setting.

• To tell your Magaya system to use the fiscal printer for invoices by default, 
check the box “Print invoices to fiscal printer by default.” This does not 
mean that all your documents will print to this printer, only the invoices. 
The system can tell which type of document it is printing. If you do not 
select this option here, you will have to tell the printer to use this printer 
by selecting it from the Print button when in the Invoice document view.
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• The option to allow a user with administrative rights to deleted voided 
invoices can be turned on, but it is off by default. It is not recommended 
that you allow this option. It is only designed for emergencies to delete an 
invoice that was printed and then voided with a credit memo.

If you want to override the global settings for the printer name, check the box 
for “Override global company configuration” and enter a division name or 
name for a branch of the company that you want printed on the documents.

Next, select the printer make (manufacturer), model, port and bits per second.

Click the “Test Connection” button to test the settings. The system will either 
display an error report or information about the printer, including the tax rates 
for this fiscal printer.

Save the settings.

Also: Set the tax rates in your Magaya system to match the tax rates defined by 
your fiscal printer. For example, if your fiscal printer includes tax rates of 5, 10 
and 15%, then you must have a rate in your Tax Table for 5, 10, and 15%. Go to 
the Chart of Accounts > Actions > Tax Table to verify this.

Add the RUC number to any entity involved in a fiscal transaction. Go to the 
entity profile, on the General tab, enter the RUC number in the field “Identifi-
cation Number.” Select “Other” for the type.
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An English-language invoice document template is available to show taxes and 
retention. Get it from File > Download Document.

Learn about printing to the fiscal printer:

http://knowledge.magaya.com/#/article/print_invoices_fiscal_printer

Denied Party Screening

The Magaya Denied Party Screening plug-in helps your company comply with 
U.S. government export regulations that require verification of entities to deter-
mine if they are included on the list of denied individuals or companies.

See the Knowledgebase topic for all the information on Denied Party Screening:

http://knowledge.magaya.com/?search=denied_party_screening

Configure Denied Party Screening

The Magaya Denied Party Screening plug-in helps your company comply with 
U.S. government export regulations that require verification of entities to deter-
mine if they are included on the list of individuals or companies who have been 
denied exporting privileges and cannot import into or export from the U.S. 
because they have been sanctioned by the government for illegal acts.

This plug-in needs to be configured to tell the system when you want to screen 
because there is a monthly service fee which includes a minimum quantity of 
screenings per month. If you go over the minimum, you will be charged per 
entity that you screen.
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The configuration screen gives you options such as when to screen the entities 
and which countries to add to the banned list.

For full details about running the screening process on shipments, entities or 
vessels, please see the Knowledegebase link below or see the Magaya Software 
Communications Manual.

http://knowledge.magaya.com/#/article/denied_party_screening
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Form Filling

The Form Filling options enable you to set how much detail you want to appear 
on the forms listed in this screen. These settings apply to the computer where 
you select the options in the screen:

The Configuration menu settings for Form Filling apply to the system for that 
computer, not the user - for example: if the user logs into another PC, they will 
see the settings for that PC, not their own settings

Check the following boxes to activate these choices:

• Expand Air waybill details: This will show one line per item in a ship-
ment. For this option to work, you must uncheck the option “Fill docu-
ments using accounting info”. If you leave this unchecked, you will only 
have a summary of the details that was entered in the “Description of 
Goods” field on the General tab of the shipment. For more on AWBs, see 
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the topics “Air Waybills” and “Air Waybill Due Agent / Due Carrier” in 
the Knowledgebase:

http://knowledge.magaya.com/?search=air_waybills

http://knowledge.magaya.com/?search=AWB_due_agent_carrier

To file the AWB electronically, read about the eAWB feature:

http://knowledge.magaya.com/#/article/eAWB_getting_started

• Expand Bill of Lading details: This will show a line in the Bill of Lading 
per item of the shipment. Checking this box will activate the “Show 
Container details” option and then it will show one line per item in the 
container. For example, if you have two containers in the shipment, each 
container will display on a separate line.

If you check the box to “Show container details” then

See also the “Ocean” configuration setting for more options.

• Expand Cargo Manifest details: This will show complete addresses of enti-
ties in the cargo manifest.

• Show Warehouse Receipt numbers in Cargo Manifest: This is unchecked 
by default.

• Fill documents using accounting info: This will use information in freight 
charges to fill operations documents such as the Air Waybill or Bill of 
Lading.
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• Show items dimensions in Master Air Waybill: This will show a line with 
the maximum dimensions of the pieces in the shipment (Pieces x Length 
x Width x Height) per IATA specifications. It also has a second option to 
show items dimensions detailed, which will show the dimensions per each 
line in the shipment on the Air Waybill.

• Use item notes as ‘Marks and Numbers’ in BL (Bill of Lading). This will 
use any notes entered about an item on the Commodity dialog box inside 
the Commodities tab. You can use the Notes field or Notes tab while you 
are working on a transaction.

Other options in the Configuration menu enable you to set the weight units for 
Air Waybills or Bills of Lading. You can choose Kilograms, Pounds, or both. 
The default is set to the use “Both”. These units are only for the Air Waybill and 
Bill of Lading and has no relation to the Measurement Units for a shipment.

Note: The Form Filling options dialog box is also available in the Shipment 
screen by clicking the button “Settings”. The Settings button can be used to 
change units per transaction if needed. Otherwise, the units are set globally here 
in this Configuration menu.

Click the Save or Reset button.
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Labels

Use this option to set the printer for Magaya Explorer. If you are using a Zebra 
(Eltron) printer model 2742, 2842, 2844, you can select the Eltron printer from 
this option so the labels will print faster.

This option also enables you to set the information you want printed on labels:

• Warehouse item description

• Company information

• Consignee name

If you do not want tracking numbers created when printing labels with part 
numbers, check the box. Learn more about external tracking numbers in the 
“Commodities” topic in the Knowledgebase:

http://knowledge.magaya.com/?search=commodities_tab

When you select the Print Labels options from the Magaya Explorer Print 
button, the print dialog box opens and gives you options for label sizes and 
quantities. For more details on the print button options, see:

Also see the Knowledgebase article:

http://knowledge.magaya.com/#/article/2_work_document_and_list

Measurement Units

With this option, you can set the measurement units for all transactions to use 
the metric system or imperial units.
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The Configuration menu settings for Measurement units apply to the system for 
that computer, not the user - for example: if the user logs into another PC, they 
will see the settings for that PC, not their own settings

Use the dropdown menus to select the measurement units and the decimal place 
for length, area, volume, weight and volume weight. For example, Length can be 
set to Inches (in), Feet (ft), Millimeters (mm), Centimeters (cm), or Decimeters 
(dm).

Notes: The measurement units set here will be used as the default for all new 
transactions. If they are set from the Charges tab in a Pickup Order, Warehouse 
Receipt, or Cargo Release, those units will only affect that individual transac-
tion. The Measurement Units options dialog box is also available in the Ship-
ment screen by clicking the “Settings” button. Using the Settings button changes 
the units for that transaction only.

Note: 166 in/Lb is the equivalent to 366 in/KG. The system will convert to kg if 
the volume weight is set in KG. Be sure to set both Length and Volume to 6 
decimal places.

Click the Save or Reset button.
126



Chapter 3
Transaction Tracking

The Transaction Tracking plug-in feature enables you to allow your customers 
to track their transactions. An email with a link is sent to your customer for each 
transaction. The customer clicks on the link and views the current status of the 
transaction in real time. It also works on a website in the Transaction Tracking 
widget. Only the transaction types checked in the Configuration screen will 
appear in the widget.

You can configure your Magaya software with options such as to send an email 
to a customer automatically whenever a transaction is generated in the Magaya 
software, or send an email message only when you want one sent. You can also 
customize the message in the email or create a template.

For more details, see the Knowledgebase:

http://knowledge.magaya.com/#/article/transaction_tracking

Customer Setup: For LiveTrack and Account Numbers

There are options available to give your customers the choice to register them-
selves online and to change their passwords themselves, without you having to 
do it for them (available in Magaya LiveTrack version 2.0 and higher). This is 
especially useful for couriers and others with many customers who want to track 
packages online.
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Steps to allow customers to register themselves:

1) Go to Maintenance > Configuration > Customer Setup: Click the 
checkbox “Allow clients to register directly on Magaya LiveTrack”.

If you want customers to be able to use LiveTrack as soon as they register, 
check this box. If not, you will need to manually enable their access from 
the Customer list by right-clicking on their name and selecting “Web 
Track User List” and unchecking the “Disable” checkbox in the dialog 
box.

2) Specify the permissions by checking the boxes for the functions you want 
the users to have access to. Some functions are checked by default. This 
sets system-wide preferences; to change it per customer, go to the 
Customer list, right-click on their name and select “Allow Tracking.”

3) Allow your customers to be able to update their passwords online them-
selves by checking the box to “Allow clients to update their password for 
Magaya LiveTrack.”

Account Number Options:

• If you want the system to automatically generate account numbers for new 
customers, click the “Set” button. In this dialog box, set the options for a 
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prefix, suffix, and a starting number. Click OK to save. Go to the 
Customer profile to view the number.

Note: When you create a new customer in your Magaya system manually 
yourself, an Account Number will be automatically filled in on the 
General tab. Then you will need to Allow Tracking for that customer by 
right-clicking on their name and creating a password for them. Then 
notify them of their access to the system via one of the email templates.

• If you want the system to automatically generate account numbers for 
existing customers who do nothave account numbers, check the box. This 
process will occur in the background, and you can continue working while 
it is being done. How long it will take depends on the quantity of 
customers in your Customer List.

Result: The customer can log into LiveTrack with their user name or 
account number.

• If you import customer names via API or other import method, you can 
tell the system to generate new account numbers in case there is a conflict.

• If you want your staff to be able to search for customers in your Magaya 
system by using the customer’s account number instead of their name, 
check this box to “Allow searching for clients by their account numbers.” 
For example, this is useful when creating a shipment or other transaction; 
when selecting the customer name from the dropdown list, you can type 
in the account number also, and the system will find the customer and fill 
in the field.
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Note: Details on how to use LiveTrack are in the Magaya Software Communica-
tions Manual, Chapter 5. To activate the LiveTrack option, contact your Magaya 
Logistics Advisor.

LiveTrack

This section controls how charges are displayed in LiveTrack.

To show charges in LiveTrack, ensure the option is checked. You can further 
fine tune the display of charges with the checkbox to only show charges to a 
LiveTrack customer if they are the “Apply To” party in your Magaya transac-
tions.

Incoming Messages

These options tell the system if you want to automatically save messages and 
what folder to place them in. The automated saving function is checked and 
active by default. If you uncheck a Save button, the system will prompt the user 
if they want to save each document received.

For more details, see Chapter 7 in the Magaya Software Communications 
Manual.
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Outgoing Messages

The Outgoing Messages screen provides setup options for sending email 
messages, shipment, and charges information. Settings made here will affect all 
Magaya users of the same database.

The Magaya email client must be used if you use the email templates. This 
screen also enables you to set the default email signature for outgoing email 
messages. It can connect to any email provider. For details, see the Knowledge-
base or Chapter 7 in the Magaya Software Communications Manual:

http://knowledge.magaya.com/#/article/configure_messages
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Sales

The Sales configuration screen enables you to set up the following options:

• Allow the create sales orders with backordered items: This means sales 
orders can be created even when you don’t have items on hand in inven-
tory

• When the orders are fulfilled, give priority to inventory within the same 
location

• Fulfill orders using inventory in the specific division: If you have more 
than one warehouse
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• Allow to create sales orders with clients as sellers: The Seller field can be 
the Customer on the Sales Order. This is useful for 3PL companies that are 
managing only the orders for their customers.

• Do not release items that have not been invoiced: When selecting this, 
another option becomes available: the option to not release items that 
have not been paid.

Allocation Settings:

• To configure your system to allocate items immediately in the Sales Order, 
check the box “Automatically allocate sales order lines when added.” This 
will take an On Hand item from inventory in the warehouse and allocate 
it for the SO. If you leave this unchecked, the system will reserve items in 
the SO, but not take a specific item from the warehouse. (Note: This 
feature is available in Magaya software version 10.2 and higher.)

• If you want your system to allocate items when the Cargo Release or Ship-
ment transaction is created, check the box “Automatically allocate Sales 
Orders when released.” Check this option if you use the Logistico plat-
form.

• Only reserve or allocate On Hand inventory in Sales Orders

For more on allocation in sales orders, see the topic “Create Sales Orders” 
in the Knowledgebase.

Enter general commissionfor inventory sales: This sets up a commission 
amount system-wide for any salesperson who sells any inventory item. To set 
commissions per salesperson, go to the Maintenance folder > Salespersons. To 
set a commission for one inventory item at a time, go to the Warehousing folder 
> Inventory Item Definitions. These options are available in the Magaya Supply 
Chain Solution.

Additional configuration options related to selling items:

• Locations allowed for Sales Order allocation: Select the locations to make 
available when adding items to sales orders

• Pricing Engine: Check this to enable pricing tiers. For details, see the 
topic on “Price Rules and Price Management” in the Magaya Supply 
Chain Solution user manual.

• Allow Drop Ship orders on outgoing shipments: Check this box to allow 
your system to place items that are in an “Ordered” status into outgoing 
shipments. Learn more about drop shipping in the topics on Sales Orders 
and Purchase Orders, available in the Magaya Supply Chain Solution user 
manual.
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Purchasing

Configure your system to determine when a bill can be created from a PO:

• Allow to create bills for Purchase Orders without commodities: Check-
mark this option to allow users to create Bills for a POs that don’t have any 
commodities, but may have other charges. This is useful to keep track of 
items such as office supplies purchased. The PO status will be “Open” (not 
“Empty”).

• Allow to create bill for Purchase Orders only after allinventory is received: 
The commodities must be On Hand to create the Bill.

• Create bills from purchase orders, including only the processed items 
(arriving, pending, or on hand)

• Allow to create Purchase Orders with clients as sellers: This will enable the 
system to display entities from the Customer List in the dropdown menu 
on the PO for the “Seller” field.

E-Commerce Fulfillment

Logistico is an e-commerce platform that connects 3PLs to online retailers who 
are looking for distribution service providers. To learn more about the platform, 
see Logistico.com for details.

3PLs who interact with Logistico.com need to configure the Sales option in their 
Magaya system to allocate inventory items when the Cargo Release or Shipment 
transaction is created. Check the box “Automatically allocate Sales Orders when 
released.”

The e-commerce fulfillment Configuration setting activates the connection 
between your Magaya system and the Logistico portal. It also gives you options 
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for setting up schedules to tell your Magaya system when to check for updates 
between the systems for inventory and tracking numbers.

For complete details on configuring your system for e-commerce fulfillment, 
see the topic “Logistico: Configure Sales Orders” in the Knowledgebase:

http://knowledge.magaya.com/#/article/Logistico_configure_sales_orders

Online Bookings

Use “Online Bookings” when you are accepting online bookings from 
customers. Here you can determine if you want to assign a booking number to 
a booking request or not and if you want to allow bookings even if you do not 
have an existing trip set up in your Magaya Explorer.
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The Online Bookings feature is available for all Magaya software. Note: This 
configuration is one part of the process required to give your customers access 
to make their own booking requests online. Additional information about using 
the Online Bookings screen is available in the Magaya Software Communica-
tions Manual. In the Knowledgebase, search for these keywords: Getting Started 
Online Bookings.

Save your settings. Note: If your online customer is logged in while you make 
these changes, they will not be affected. If you want a customer to have a feature 
available to them, they must log out of LiveTrack and log back in after you make 
a change in the Configuration menu.

Additional information about using the Online Bookings screen is available in 
the Magaya Software Communications Manual and in the Knowledgebase:

http://knowledge.magaya.com/#/article/online_bookings_intro

Online Payments

There are two ways to manage payments online: via First Data or PayCargo.

To give your customers the option to pay you online by by e-check (ACH) 
configure the online payment option for the service provider PayCargo.

To give your customers the option of paying their invoices with a credit card, 
configure the First Data section of the screen.

Configure PayCargo:

PayCargo is a service provider which is designed specifically for freight 
forwarders and others in the shipping industry.
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Check the box on this screen to enable online payments via PayCargo, and select 
the accounts you want used for the invoice payments (deposits) and fees:

• When you select the bank account for the Invoice Payments, then all 
payments received will be posted to this account.

• The Bank Account for the Service Fees is the account that all service 
charges will go to.

• The Expense Account is for the processing expenses. When you create a 
Profit & Loss statement, the processing expenses will appear on the report 
under this expense account.

• The Service Provider of PayCargo LLC is set in the system by default.

Next you and your customers must register with www.PayCargo.com.

Configure First Data:

Check the box to enable online payments with First Data.
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If you don’t have a First Data account, click the link to their website to create 
one. They will give you the details to enter into the Magaya screen: the Exact ID, 
Password, Key ID and Key.

Note: The Test environment is only for testing the system. Leave this box 
unchecked.

After you enter the data, the system will test your Magaya account and your 
First Data account.

Save your settings. Note: If your online customer is logged in while you make 
these changes, they will not be affected. If you want a customer to have a feature 
available to them, they must log out of LiveTrack and log back in after you make 
a change in the Configuration menu.

Next, you will need to enter the customer’s credit card information in their 
Customer profile. Then the credit card can be applied to invoices. For details on 
how to use the online payments feature, see the chapter on online payments in 
the Magaya Software Communications Manualor the Knowledgebase:

http://knowledge.magaya.com/#/article/online_payments_getting_started

Online Sales Orders

To offer your customers the option to buy inventory from you online, you can 
set up your system for online sales orders.

This feature requires this configuration setup and the creation of inventory 
categories in the Inventory Organizer (under the Warehousing folder). Each 
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customer must have tracking enabled in their profile. See the Magaya Supply 
Chain Solution Manual for details.

1) Check the box to allow online sales orders, and then choose your prefer-
ences:

2) Allow back orders of items. This gives you the option to let your customers 
place orders for items that are not currently on hand in your inventory. 
The backordered items are added to the “Backordered Items List”. Details 
are in the Magaya Supply Chain Solution Operations Manual.

To create a Purchase Order automatically to buy the items from a 
preferred vendor, check the box.

3) Allow client invoice generation automatically: The system will create the 
invoice, transferring the details of the sales order into an invoice, and send 
it to the Invoices folder in your Magaya system.
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4) Allow orders to be taken in your home currency only. If you uncheck the 
box, your system will accept orders in other currencies. Your system must 
be configured for multicurrencies (set in Maintenance > Configuration > 
Accounting).

5) Generate charges automatically for online sales orders: Check this box to 
enable the system to include charges on sales orders that customers place 
online (which the customer will see). To define which charges to auto-
mate, go to the Intems & Services list, and configure the charges there.

6) Allow your customers to cancel online sales orders: Check this box to acti-
vate this. (Available in Magaya software version 9.2+ and LiveTrack 1.0, as 
of the date of this documentation, March 2014). The customer can 
right-click on a sales order to cancel it. Note, if a Magaya user creates a 
S.O. in the Magaya Explorer (not online), the customer cannot cancel that 
S.O. (A Magaya user can cancel a S.O. via the Actions button or by 
right-clicking.) Any canceled S.O. will have a status of “Canceled” and 
display in the S.O. List. The items will be returned to inventory.

Sales Orders that have already been canceled or contain items that have 
been canceled from a Purchase Order may not be canceled again. Sales 
Orders that have already been invoiced or loaded onto a shipment or 
cargo release cannot be canceled.

7) Automate Job creation in your Magaya system for each sales order posted. 
The system will automatically create a Job to track the progress of all trans-
actions related to the job such as invoices, sales orders, etc. This will link 
the sales order and the items inside it to the Job.

8) Allow automatic release of the ordered commodities, and define the type 
of release to be created automatically: a Cargo Release or a shipment will 
be created in the system.

9) Save the shipments in a folder you specify when you select the option 
“Create a Shipment”. Then click the “Select” button to open a list of 
folders so you can navigate to the folder of your choice.

10) Select the modes of transportation for the orders. These modes will be 
visible to online users in Magaya LiveTrack.
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Feature a Category: After you create categories for inventory in the Inventory 
Organizer (found in the Warehousing folder), you can select a category here to 
feature it in the Online Sales Order screen in Magaya LiveTrack. This will 
display only this “root” category and its subcategories. This is useful if you 
create internal categories such as commissions that you do not want to be visible 
to customers online. This is optional and can be changed at any time.

To notify your customers that their online order was received and is being 
processed, go to the Email Templates or System Alerts configuration screen to 
choose the option you prefer.

Online sales orders is available in the Magaya Supply Chain Solution and the 
Magaya Commerce System.

For more details, see the Magaya Software Communications Manual.

Save your settings. Note: If your online customer is logged in while you make 
these changes, they will not be affected. If you want a customer to have a feature 
available to them, they must log out of LiveTrack and log back in after you make 
a change in the Configuration menu.

Online Shipping Orders

To give your customers the option of sending you shipping instructions online 
via Magaya LiveTrack, set up the option in the Configuration menu:

• Check the box to allow online shipping orders (shipments and cargo 
releases).

• Select the modes of transportation you want to enable.
 141



Chapter 3
• If you want to save the shipments in a different folder in your Magaya 
system other than the existing one, click on the “Select” button to navigate 
to the folder you want.

• Check the option “Save clients when entering online orders” to save the 
entity names and details that your LiveTrack users enter online.

This configuration screen also offers options for online pickup orders.

Online shipping orders is available in the Magaya Supply Chain Solution and 
the Magaya Cargo System.

Save your settings. Note: If your online customer is logged in while you make 
these changes, they will not be affected. If you want a customer to have a feature 
available to them, they must log out of LiveTrack and log back in after you make 
a change in the Configuration menu.

Details on how to use the online shipping orders feature are available in the 
Magaya Software Communications Manual. See also the Knowldegebase for the 
article: “Getting Started with Online Shipping Orders:”

http://knowledge.magaya.com/#/article/online_shipping_orders_intro

US Customs Systems

The US Customs and Border Protection (CBP) options in Magaya software 
provide fields to enter details for: 

• Imports, using the Automated Manifest System (AMS) codes and 
Importer Security Filing (ISF) codes

• Exports, using the integrated connection to the ACE portal (formerly the 
AES system) to file EEI

• Customs Brokers, using the Automated Brokers Interface (ABI) that is 
integrated with the SmartBorder system

After you set up your Customs information in the Configuration menu, it will 
fill in automatically in shipment documents.

US Customs features are available in the Magaya Supply Chain Solution and the 
Magaya Cargo System.

For more details on each one, see topics in the Knowledgebase and in the 
Magaya Software Communications Manual.

http://knowledge.magaya.com/#/article/intro_config_customs
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Express Link

Magaya Express Link plug-in enables you to request package shipments from 
carriers such as UPS and FedEx. It needs to be activated in your Magaya account 
and configured in your Magaya system. Full configuration and usage steps are 
explained in the Knowledgebase and in the Magaya Software Communications 
Manual.

Start with the Knowledgebase article “Express Link: Getting Started”

http://knowledge.magaya.com/?search=ExpressLink_Get_Started

WMS

The WMS configuration section contains settings to start using the Magaya 
WMS Mobile plug-in application. The screen contains the following tabs and 
options:

These details are explained in the Knowledgebase and in the Magaya WMS 
Operations Manualand in the Magaya Supply Chain Solution Manual.
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Final Mile App

Use the Final Mile app is used by delivery drivers so they can collect signatures 
when they pick up and deliver goods. The application runs on smart phones and 
provides a list of tasks, a description of the cargo to be delivered, the address and 
a map. (It was formerly called the POD Mobile app.)

For more details, see the knowledgebase:

http://knowledge.magaya.com/#/article/final_mile_getting_started

Scales and Identification

This Configuration option contains two section which set up your Magaya 
system to scan and capture data about items as they arrive in your warehouse:
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• Scales: The “Scales” tab on this screen includes settings to connect a scale 
to your Magaya system so you can weigh and measure packages quickly.

• Identification: The “Identification” tab on this screen includes settings to 
configure fixed mounted linear bar code scanners and cameras, which will 
scan the bar code labels on packages as they are passed through the 
CubiScan machine and take pictures of each item. The data is saved in a 
“Pickup Order Courier Manifest” document/transaction.

To use the CubiScan, you will need to activate a Magaya plug-in application 
called Magaya Scale Integration. The CubiScan scales are the only manufacturer 
that is currently integrated with Magaya software.

Contact Magaya to activate this plug-in and discuss installing and connecting 
the scale or bra code scanner to your Magaya system. You will need the IP 
address to assign to the scale, cameras or scanners, and the Port.

The advantage of combining these hardware products with your Magaya system 
is to speed up receipt in the warehouse. This is especially helpful for couriers 
who handle a high volume of small packages.

See the following Knowledgebase article for full details on configuring the scales 
and other hardware and setting preferences for printing labels and saving 
tracking numbers from the packages:

http://knowledge.magaya.com/#/article/Cubiscan

This plug-in is useful when receiving items from UPS or FedEx. Then the end 
customer can track the item by this tracking number when they use the Magaya 
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mobile app, Track2Go. This tracking number will also be searchable within 
your Magaya database.

eAWB

To file electronic air waybills (eAWB), contact your Magaya sales representa-
tive. This service is charged per transaction. Discuss the charges with your 
Magaya representative.

Magaya will create a code called a PIMA code for you and give it to you. Enter 
the PIMA code into the eAWB Configuration screen.

For more on the eAWB such as IATA requirements, see the topic "eAWB: 
Getting Started" in the Magaya Knowledgebase:

http://knowledge.magaya.com/#/article/eAWB_getting_started

Air

The Air Configuration menu includes settings for your system.

To comply with IATA regulations, set the following configuration options as 
needed for your company.

Each setting will change the way your system handles Air Waybill (AWB) 
numbers. Verify your needs before making changes. Changes will be reflected 
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in the Carrier's profile (in the Maintenance folder) and/or in the air shipment 
wizard as explained below.

• Compliance: Do not allow duplicated Air Waybill (AWB) numbers

• Set a default mode of transportation. After setting this, the choice will be 
filled in when creating Bookings, Trips and Shipments.

• Tracking: Display Master shipment events when tracking House ship-
ments. This allows the tracking user of the House shipment to see the 
events of the Master shipment. This is displayed to the user when they log 
into LiveTrack and view their shipments.

• Generate Air Waybill numbers by range: Use this option when an air 
carrier sends you a batch of AWB numbers.

a) Check this box to tell the system to generate AWB numbers by 
range.

b) Click “Save” in the Configuration screen.

c) Go to the Carrier's profile > the "Airline" tab > click the "Add" button 
to add AWB numbers. A dialog box opens. The system grays out all 
the options except for the setting you made in the Configuration 
screen. Enter the beginning and ending range of numbers in the 
fields, and click the "OK" button to save. The system will generate the 
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numbers in the range for you. They will be displayed in the screen. 
The numbers will be available to use in air shipments.

The other option on the dialog box is to "Generate an amount of Air 
Waybill Numbers". This allows the system to create the AWB numbers by 
starting at the number you define.

• Enforce Air Waybill numbers to comply with IATA regulations: This 
setting will disable a checkbox on the dialog box in the Carrier's profile > 
the "Airline" tab which opens when you click the "Add" button. This 
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checkbox is "Check digits". It will be grayed out. This forces compliance 
with IATA regulations.

• Air Waybill numbers assigned in sequential order: When you select this 
configuration, it will affect how AWB numbers are used when creating air 
shipments by forcing the system to use the next AWB number in the 
sequence. You will not be able to select an AWB number from a list. If you 
want to allow users to select any AWB number, do not check this box.
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Ocean

The following Configuration options are available for ocean shipments:

Compliance:

• Validate container numbers: Check this option to ensure any container 
number entered is valid. The system will not accept invalid numbers.

• Do not allow duplicate Bill of Lading numbers: Check this option to 
ensure a duplicate Bill of Lading number is not entered into the system.

• To include container waybill notes in the Bill of Lading, select the option 
in this configuration screen.

Result: In a Shipment, the Container dialog box has a tab called "Waybill 
Notes." Click the button to add notes.

• Set a default mode of transportation. After setting this, the choice will be 
filled in when creating Bookings, Trips and Shipments.

Tracking:

• Display Master shipment events when tracking House shipments. This 
allows the tracking user of the House shipment to see the events of the 
Master shipment. This is displayed to the user when they log into Live-
Track and view their shipments.

INTTRA:
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• If you have the connection with INTTRA, you can configure your Magaya 
system to send container waybill notes in INTTRA requests. You can also 
tell your Magaya system to send alternate shipment identifiers.

VGM: Ocean containers must have their gross mass verified before the 
container arrives at the port. The data of the container weight and the person 
who verified it can be printed from the VGM document in Magaya 10.2 (or 
newer) or emailed. Also, INTTRA enables e-filing. Contact Magaya for more.

Ground

Compliance:

• If you want to configure your Magaya system to prevent duplicating bill of 
lading numbers for ground shipments, check the box.

• Set a default mode of transportation. After setting this, the choice will be 
filled in when creating Bookings, Trips and Shipments.

Tracking:

• Display Master shipment events when tracking House shipments. This 
allows the tracking user of the House shipment to see the events of the 
Master shipment. This is displayed to the user when they log into Live-
Track and view their shipments.
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Custom Fields

Custom fields can be added to any transaction and used in document templates, 
lists, reports, combo boxes (dropdown lists), filters, when transmitting or 
converting transactions, export/import, and more.

Custom fields become available as a new tab in the transaction you customize, 
configure and group, and appear in lists in Magaya Explorer. You can specify if 
you want the Custom Field to be visible to employees internally but not visible 
to customers.
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You can add as many custom fields as you need. When you are done, the custom 
field will appear as a tab in your transaction. This is a Warehouse Receipt dialog 
box with the Custom tab and custom fields:

There are many different types of custom fields:

See the topic “Custom Fields” in the Knowledgebase link below or Chapter 4 
“Custom Fields” in the Magaya Software Customization Manual:
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http://knowledge.magaya.com/#/article/custom_fields

JavaScript Code

JavaScript is a scripting language used in Web pages to add functionality, inter-
activity, validate forms, detect browsers, and more. It works in all major 
browsers. This function in Magaya software enables you to create a library of 
scripts that you can use for functions such as calculating rates, customizing 
prices for your online store when you define an inventory item, etc.

The following buttons across the top of the JavaScript work area are:

• My Code: This is the work area where you can type in code.

• Resources: This is a library of source code of useful functions you can use.

• Copy, Cut, and Paste: These button work similar to other copy, cut, and 
paste buttons to allow you to copy, cut, and paste code.

The Function Name dropdown menu selects from Function names you have 
added to the system. If you have not added any, the list will be blank.

The Parameters List is a field that is used to enter the parameters for the func-
tion you want to test. Separate the parameters with commas.
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Click on the Execute button to test your code.

The Result window at the bottom displays the result of the selected function 
executed with the above parameters. If there is an error, an error message will 
appear here.

Extra Info: JavaScript can be used in the Magaya Document Designer. See the 
Knowledgebase for articles, and contact Magaya.

Transaction Log

Use this option to tell the system to save a record of any changes made to trans-
actions in Magaya Explorer. This will keep a history of what users have modified 
or deleted.

• The Transaction Log is set by default to keep a record of all deletions made 
to transactions. You can specify if you want to keep a record of the 
creation and/or the modifications.

• Check the boxes you want and then click Save (or Reset).

Any changes made to the configuration screen of the Transaction Log (or any 
configuration menu option) will be recorded in the log.
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To view the Transaction Log, go to the Options menu on the top toolbar in 
Magaya Explorer. Select “View Transactions Log”.

The log opens, showing the type of transaction, its Object ID, the name or trans-
action number, the date, the employee, and more. The date range can be 
changed.

To view an individual transaction, select it, click on the Actions button and 
choose “View record”. Other options in the Actions menu are Restore record, 
View previous state, Clean up Transactions Log, and Choose Columns. When 
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you select the option to clean up the transaction log, a dialog box opens with 
options.

To maintain the Transaction Log, go to the Maintenance & Performance 
configuration option. In the “Recycling” section, click the “Configure” button 
and set the number of days to keep records in the Transaction Log. This setting 
will remove the transactions from the log, but they will be saved in your backup 
files. This will help keep your database optimized and improve its performance.

Security

The Security configuration screen enables you to set the level of authentication 
for users when they log into the database. You can also set up single sign-on for 
Windows.
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CAUTION!Ensure all users are logged off first.

• Application-level authentication: Result of this setting: When users log in, 
they selecttheir user name from a dropdown menu.

Use Integrated Windows Authentication (single sign-on): Users can log 
into their Magaya system on their PC or in the cloud using their creden-
tials when they sign into their Windows systems. The users (employees) 
in your Windows Active Directory or Workgroup can use their same login 
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and password to access Magaya software in the cloud as they use to log 
into their computers.

If your company has strong password security rules to access your 
Windows system, then those same security measures can now apply to 
Magaya access. It works across multiple domains and workgroups.

To activate this single sign-on: (administrator permissions required)

In the Security Configuration screen, check the box to activate this feature.

Type in your domain or workgroup name. Save.

Go to the Employee profile: On the User tab, type in the domain (or work-
group) name. Click OK to save.

For a video demo, see the 10.4 webinar recording posted on the Magaya 
News page. Fast forward to 21 minutes into the recording to see the demo 
on single sign-on:

http://www.magaya.com/News/PostId/163/magaya-new-features-104-w
ebinar-recap

• Database-level authentication: This setting does not show a dropdown list 
of user names. The user must type their name. This is a higher level of 
security.

Before performing this configuration, ensure you know your user name and 
password. When you log back in, you must type your user name and password.

All users must be logged off to set this configuration, except for the adminis-
trator performing this task. You must also exit from the Magaya Communica-
tion Server.

The Magaya Communication Server will also require user login credentials the 
first time you make this configuration change. Create a user in your Employee 
list for the Magaya Communication Server. Log in and then restart the Magaya 
Communication Server.

Then go to the Employee list and view each employee profile > User tab to see 
and make a note of the user name that the system created for you. Give this login 
information to each employee so they can log in with the new method.

Learn about additional admin tasks:

http://knowledge.magaya.com/#/article/admin_overview
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Maintenance & Performance

This configuration screen provides optimization options you can choose as 
needed. These options are designed to improve the performance of your 
Magaya system.

• Start up: This option improves performance by pre-loading entities such 
as Customers and Vendors. If you have many entities, you can uncheck a 
box so that your Magaya Explorer starts faster. The entities unchecked will 
load as needed when you use that feature in the system.

• Attachments & PDF Options: Optimizing an image for the Web will 
reduce the file size so it is faster to email or download. If you want the 
system to ask about optimizing images first, check the boxes.

The system uses black and white colors for the background of PDFs as a 
default.

• Recycling: These options are explained in detail in Chapter 8, Magaya 
Database Administration. Please read all the steps in that chapter carefully 
before configuring the Recycling options.

Learn more about database performance:

http://knowledge.magaya.com/#/article/database_performance
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Task Scheduling

This function is reserved for the system to display a list of scheduled tasks such 
as checking with UPS or other carrier for updates if you are using Magaya 
Express Link and for inventory replenishment. You can setup a schedule to 
check inventory stock levels. In the future, other repeating tasks may be added.

Learn about replenishment:

http://knowledge.magaya.com/#/article/replenishment

Clauses

You can save clauses in Magaya Explorer for notes that you add frequently to 
transactions. For example, you may have a clause such as “Consolidation as per 
attached cargo manifest” that you add to master shipments. Save this clause or 
any others in your Clauses List and it will be available for use every time you 
need it.
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Clauses can be added in the Configuration screen or while you are working in a 
transaction such as a Warehouse Receipt. This is the Configuration screen:

• Click on the Add button to open a dialog box where you can create a new 
clause.

• Enter a name for the clause and the Clause Text (a description). Also select 
the category from the dropdown. The Category list shows all the transac-
tions you can add the clause to such as Warehouse Receipts, Invoices, Bills 
and more. To add a category not listed, click on the button with the three 
dots.

Shipment Documents

Use this option to set your system to automatically include specific shipping 
documents in shipments when they are created. For example, if you always want 
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an air waybill (AWB) included in every air shipment created, assign it here so 
that the document will be automatically included.

To select a document and assign it to a shipment, click the “Add” button. In the 
dialog box, select the document and set the options:
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Each document has options that apply to it such as options for House and 
Master for the Bill of Lading.

If you don’t want this document to appear to the customer when they log into 
the tracking, click “Exclude from Tracking.”

The shipment documents option is available in the Magaya Cargo System and 
Magaya Supply Chain Solution.
164



Chapter 3
System Alerts

Use this option to create your own customized alerts. The alerts can be for 
employees or others outside the company.

The screenshot shows an example of an alert that will send a Task to the 
employee shown. You can also choose to send the alert via email. Customize the 
subject line and body of the message according to your needs. There are many 
options under the “When” field such as notification that a customer signed up 
on LiveTrack, a sales order was placed online, and more. The message is sent 
using the template you select.

Check the box to enable to alert.
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Commodity Types

Use this option toadd commodity types to your Magaya system. 

By entering a commodity type here, it will enable you to assign rates by 
commodity type and to receive cargo in the warehouse by commodity type so 
the charges for the items will use the rate you assigned.
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Divisions

If your company has different divisions, you can set up the divisions in the 
Configuration screen. As a result, the division will appear as a dropdown menu 
in transactions. When you select that division, the address of the division will 
appear on the documents. Employee permissions can be assigned based on divi-
sion. This setup can limit the employee view to their division, if you want to.

The Divisions list can also be accessed from the Actions button in the Employee 
List.

Click the “Add” button to add a new division:

• On the first tab, “Division”, enter the division name.

• Enter the phone number, fax number, and email (optional).

• Select the default company. The default company is the associated 
company of the division. The dropdown shows companies you have listed 
in the Forwarding Agents subfolder under the Maintenance folder.

• Check the box if you want the division name to appear in documents such 
as Air Waybills or Bills of Lading.

• Check the other box to assign this division to entities created by its 
employees. This will limit this employee’s view of the system, so they will 
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only see entities they create. Also assign the employee to a Division, after 
you create the Division. You can also assign a Warehouse Zone to a Divi-
sion to further control the employee view.

• Add any comments as needed.

• Click on the Address tab and enter the address. This address will appear 
in the documents created by this division.

• Click on the US Customs Codes tab and enter the Air AMS Originator 
Code (if needed). This is used when filing AMS from the division.

• Click the OK button when you are done.

See the following Knowledgebase article on Divisions:

http://knowledge.magaya.com/#/article/divisions

Also see the Accounting Configuration menu > Miscellaneous tab to review the 
option that will enable the main company to view accounting transactions made 
by divisions.

Event Definition

Magaya software enables you to define events so you have a list ready to select 
from and use in the Events tab.

To enter a new event definition, click on the Add button.
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• Enter a name for the event in the Name field of the dialog box.

• Enter details on the event (optional).

• Select a location to connect with that event (optional).

• Select from the dropdown to choose the type of automatic creation for this 
event. There are many options: You can make an event appear in a WR or 
Cargo Release when it is created, set as “In Transit,” emailed, or liqui-
dated. If you choose “Automatic”, the event will be added to the transac-
tion and will be visible to the customer. Selecting “Manual” will not 
automatically create an event. You will have to select it each time for each 
WR transaction you are creating such as a WR.

• Check the box to include the event in tracking.

• Click OK when finished.

Learn about adding events to transactions:

http://knowledge.magaya.com/#/article/events

Incoterms

Incoterms are international trading terms that define the point in time in which 
the responsibilities and liabilities for cargo switch from the seller to the buyer.
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The Magaya system includes a default list of incoterms. To add new incoterms, 
click the Add button and enter the code and description in the dialog box.
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Task Types

The Magaya system includes a default list of Task Types.

The column “System” identifies which Task Types are created by the system. If 
they were created by the system, they are marked as “Yes”. This type of task 
cannot be deleted. When you create a task, it is marked “No”.

To add new types, click the “Add” button and fill in the information in the 
dialog box for a descriptive name and what class of task it is.

A “Generic Task” can be informative, for example, used to inform an employee 
such as a salesperson to do a task.

XML Transformations

Users can define a transformation for a specific transaction type. For example, 
if there is a third-party accounting system that receives an invoice in a specific 
format, you can write a transformation to convert the Invoice to the required 
format of that system. Formats can be XML, CSV, or other format.

Another example of an xml transformation is to convert shipment data into the 
format needed for the Asycuda customs system. For more on Asycuda, see the 
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topic in the Knowledgebase “Export a Magaya Shipment to an Asycuda Mani-
fest File” :

http://knowledge.magaya.com/?search=asycuda_shipment_manifest

Then when the transformation entry is ready, the user opens the Invoice List, 
selects the range of invoices to be exported, and clicks on the "Export" button to 
select the available transformation (the one you define here). This will create a 
new file in the required format.

• Type a description

• Choose the source: Local is your computer or network, and Online is a 
URL.

• Choose the format of extension (Import or Export).

• Select an element type (such as a transaction of an Invoice, Bill, etc.). For 
example, if you want to transform a shipment for the CASS system, select 
“Shipment” to make it appear in Actions > Export > XML.

• Click OK to save it.
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Email Templates

The system includes some default email templates. You can also add your own 
to be used throughout your system by all employees. Images and links can be 
added to email templates as well as other customizations.

The Email Templates are explained in detail in the Knowledgebase link below 
and in Chapter 7 of the Magaya Software Communications Manual.

http://knowledge.magaya.com/#/article/email_templates

Payment Terms

Define your own payment terms for entities such as customers and vendors. 
With this configuration option, define the due date or a discount for early for 
early payment. Then apply it to transactions such as Purchase Orders and more.
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The system includes a set of Payment Terms. You can add more as needed.

Overview of how it works: When the Payment Term is selected in the PO dialog 
box (for example), the Due Date field updates automatically. Customer 
discounts will be applied automatically and show in Invoices.

Set systemwide Payment Terms and default accounts in Configuration > 
Accounting. This configuration option is available in Magaya software 9.3 and 
above.

Full details are explained in the Accounts Receivable chapter in the Magaya 
Software Accounting Manual.

Learn about working with payments in Magaya software:

http://knowledge.magaya.com/#/article/payments
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Chapter 4
Custom Fields

Magaya software gives you the option to add fields that gather specific, custom-
ized information you need. These custom fields can be used in transactions in 
Magaya Explorer; in the templates that build documents and forms such as 
Warehouse Receipts, Cargo Releases, and others; in lists, reports, combo boxes 
(dropdown menus), and filters.

Custom fields can also be used when transmitting or converting transactions, 
importing or exporting information to and from your Magaya database, and 
more. Custom fields can also be viewed by your customers who log into Live-
Track and select them from the Actions > Choose Columns dialog box.

Custom Fields Example

For example if you ship vehicles, you may need to track certain information 
about the vehicles and generate a report. With custom fields, you can add any 
field you need and answer questions about the vehicle shipments such as:

• Is the title with the vehicle?

• Are the keys in the vehicle?

• Does the vehicle have gas?

• What is the color of the vehicle?

Custom Field Types

With the custom fields options, you can create and group different types of 
fields:

• Dropdown lists of choices (you set them or choose from your existing list 
of entities such as customers, carriers, vendors, etc)

• Text fields that can be filled in (you set the character limit)
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• “Yes or No” fields

• Number fields and currency fields (whole numbers or include a decimal 
place)

• Date and/or time fields

When you add a custom field, it becomes available as a new tab in the transac-
tion, such as this shipment:

Custom fields can be grouped and displayed on the Custom tab. You can define 
the group name.

Additional functionality: You can make the custom field visible for employees 
internally but not visible to customers.
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Custom fields are also included as a column in any list in Magaya Explorer 
(from the Actions button, click on “Choose Columns”):

Custom fields will display in documents you customize with the Magaya Docu-
ment Designer. For example, if you create a custom field for your Warehouse 
Receipts and place the cargo from the WR into a Shipment, the custom field will 
appear in the Shipment transaction as well.
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Create Custom Fields: Step-by-Step Procedure

1) Go Maintenance folder > Configuration (or click the Options menu on 
the top toolbar).

2) Click “Custom Fields” from the menu.

3) In the list of Customizable Elements, select the element you want to 
customize such as Cargo Release, Invoice, or Warehouse Receipt.

This example will use the Warehouse Receipt element and create a custom 
field for the following question: Are the keys with the vehicle?

Note: The buttons on the right are grayed out until you select a customiz-
able element. Then the Add button is active. When you add a field, it 
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displays in the list of Custom Fields. When you click on a field, the other 
buttons become active.

4) Click the Add button to create a custom field for the question. A dialog 
box opens:

The Field Type is set to “Text” by default. Under the Field Type is 
“Maximum Length”; this number is set to 100 by default. This number 
applies to the maximum number of characters allowed in the custom field 
you are creating: the user must answer with 100 characters or less. The 
Maximum Length field only appears when you use the Text field type. You 
can select a Field Type before or after entering a Display Name.

5) Enter the following text in the Display Name field (do not include the 
quotation marks) for this example: “Key in Vehicle?” This is the name that 
will appear in the reports and in transactions. (Note: The Internal Name is 
assigned by the system. If you make an error such as spell a word incor-
rectly and you save the custom field, you can edit the Display Name but 
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not the Internal Name. If you need to change the Internal Name later, you 
must delete the custom field and create a new one.)

6) Enter or select a category (optional).

7) Enter a description (optional). This will not display on the transaction. 
This explains when and why this question is used.

8) Change the maximum length (optional). This is the maximum number of 
characters allowed for the answer.

9) Select what type of field you want. A dialog box opens, displaying different 
options depending on which type of field you choose. These are the 
options:

• Text will allow text to be entered in the answer field. You can set the 
maximum number of characters. The default is 100. This option will 
give the user a free-form field, so they can type in the answer to the 
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question. This is useful for answering questions such as “What is the 
color of the vehicle?”

If the text might fill more than one line, click the “Mulitline” 
checkbox.

• Integeris for whole numbers (no decimal places). Use this option 
when you want users to enter a whole number as the answer.

• Decimal will allow you to specify the number of decimal places. Use 
the Precision dropdown to select the decimal places. The default is 
two places.

• Pick List will create a dropdown list with choices you specify 
(similar to multiple choice):

Click on the Add button to add to the Pick List. A text box opens:

Enter text in the box and click OK. The text will be added to your 
Pick List.

• Yes/No is used to answer yes or no questions.
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• Date can display the date field. To include the time, check the box 
“Date and Time.”

The user will see a calendar when they click on the Date and Time 
dropdown in the Custom tab of a transaction such as a Warehouse 
Receipt:

• Money will allow you to specify a currency amount. Use the Preci-
sion dropdown to select the decimal spaces. The default is two 
spaces.
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• Lookup will allow the user to select from a dropdown list of the enti-
ties you set such as Customers, Forwarding Agents, Carriers, etc.

When you select the Lookup field, the user will have a dropdown list 
to choose from such as on this WR dialog box:

This example does not use categories to group custom fields.
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• Calcuated Custom Field: This type can calculate a value such as an 
amount in an invoice. Click the “Code” button to enter the JavaS-
cript.

When writing code to be used in Calculated Custom Fields, the 
XmlDocument object and the XmlItemDocument object will not be 
available. This limitation applies to the code you enter here and any 
function that could be called from there.

10) Check the box to “Allow to build reports by this field” to allow this custom 
field to be available in reports in Magaya software:

Other options are:
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• If you no longer need a field, there are two options: You can delete a 
custom field completely, or you keep it in your system but make it 
inactive. To deactivate a custom field, check the box “Field is Inac-
tive”. The inactive field will not appear in filters or lists unless there 
is data in that field from a previous transaction.

• If you want to create a custom field for internal use only, check the 
box “Internal Use Only”.

You can add as many custom fields as you need.

Custom fields can be edited, deleted, copied, rearranged, imported, or exported 
from Magaya Explorer to another program by using the buttons shown:

To move an element up or down, select it and click the button you need. For 
example, in this example the element “Key in vehicle” is the first in the list. If 
you want to move it down the list, select the element and click the Move Down 
button. The element will move down one place.

Select the field to edit, delete, etc. and click the button needed. When you delete 
a field, it is deleted from the list in the Custom Fields screen, from the transac-
tion tab, and from the Reports menu. If you delete a field that was used in trans-
actions, you will still see that field in the Advanced Filter. This enables you to 
filter by that field for any past transactions that used that field.
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The “Copy To” button will open a dialog box so you can copy that field to 
another transaction so you do not have to recreate the elements.

Result: After you add a custom field, it becomes available as a new tab in the 
transaction. The dropdown fields will display <none> until a selection is made:

If you created categories, they will display on the Custom tab, grouping all the 
fields for each category together. If you don’t define the name for a category, the 
system will name it “Group 1” for the first one and number the rest.

The Customizable Element “Warehouse Item” will appear on the Commodity 
dialog box after the commodity is added to a transaction such as a Warehouse 
Receipt.
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The information added into the Custom Fields will be automatically carried 
over to any other transactions you create from this Warehouse Receipt such as 
to a shipment.

If you add Custom Fields to an Inventory Item Definition, those fields will auto-
matically appear on the Commodity description when you receive those items 
in the warehouse.

Include Custom Fields in Documents:

To include custom fields in your documents such as Warehouse Receipts, Cargo 
Releases, etc., you will need to add the same fields to the templates for those 
documents by using the Magaya Document Designer. Then you will select that 
template to use for those transactions. For details, see the topic “Magaya Docu-
ment Designer”.

Custom Fields in LiveTrack:

Custom fields can also be viewed by your customers who log into LiveTrack and 
select them from the Actions > Choose Columns dialog box.

Custom Fields in Reports: Vehicle Example

After you create custom fields, you can see the information gathered by the 
fields and placed in a report. In order to create a report that uses custom fields, 
that field must have a checkmark in the box to use in reports.

To generate a report of this information, click on the Actions button in the list 
you are working on. For example, if you made a custom field for “Vehicle 
Status” and you need to see a report of the vehicle status for all vehicles received 
in the warehouse, go to the Warehouse Receipts List and add the custom field 
to that list.

Then, click the Actions button.

• Click on “Reports” and select the report you want. In this example, we are 
looking for vehicle colors. (When the custom field “Vehicle Color” was 
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created, the checkbox was activated to allow this field to be used in 
reports.)

• The report opens, showing the colors of all the vehicles in the date range 
you want to see in this report.
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• The column headings in the report are the ones checkmarked in the 
“Choose Columns” dialog box.

The custom fields you can see are the ones created and activated to be 
listed in reports.
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Custom Field in Report: Invoice Example

In this example, the first step is to add a custom field to the Invoice (this is done 
in the Configuration menu > Custom Fields. The example custom field added 
was "Invoice Reference Number").

Then the custom field is added to the Invoices List. This is done by going to the 
Invoices List, clicking Actions > Choose Columns, and clicking the "Add 
Columns" button on the bottom of the "Column Settings" dialog box.

Then in the "Related Columns" dialog box that opens, select the related element 
"Invoice" and check the custom field name ("Invoice Reference Number") in the 
list. Add it to the "Selected Columns" side of the dialog box.

Click OK to save. Then the column appears in the Invoices List.

Next, select the report (this example uses the A/R Aging detail report, found 
from the Actions button in the Invoices list > Sales Reports).

In the report view, click Actions > Choose Columns. Then click "Add Columns" 
and in the related elements list, select "Invoice" from the dropdown, scroll to 
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find the custom field ("Invoice Reference Number"). It appears in the report. 
You may need to widen the column to view the full name of the column header.

Custom Fields in the Advanced Filter

When you create custom fields, they will be available in the Advanced Filter. 
You can filter a list to see the information that was gathered in the custom fields. 
For example, this Advanced Filter screen shows the fields available in the Ware-
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house Receipt list, including the custom fields added that gather information 
about vehicle color and status:

Steps for using the Advanced Filter are available in the Magaya Cargo System 
Operations Manual in Chapter 5.

Add Custom Field to a Document Template

Document templates can be customized to display data from Custom Fields. 
These templates can be selected in transactions such as the Warehouse Receipt 
document view Actions button. You can copy an existing document template in 
that screen; the Magaya Document Designer application opens. For details on 
using the designer, see Chapter 5.
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Magaya Document Designer: Getting Started

Introduction to the Magaya Document Designer

What is the Magaya Document Designer?

Magaya Document Designer is a tool you can use to customize existing Magaya 
documents or create new ones by creating custom templates.

Your Magaya system includes a set of documents which are filled in with data 
with you create transactions using the wizard and dialog boxes. Document 
templates that can be customized using the Document Designer include:

• Quotations and Bookings

• Pickup Orders, Cargo Releases, Labels, and Packing Slips

• Purchase Orders and Sales Orders

• Warehouse Receipts and Warehouse Receipt Labels, and Cargo Moves

• Shipment Documents, Shipment Master and House Labels

• Invoices and Bills

• Payment Receipts, Checks, Deposit Tickets, Journal Entries and Client 
Statements of open invoices with applied payments and balances

You can insert your company logo into documents, create a separate layout for 
each page of a document, and define the printing of copies for different entities 
such as the carrier or agent.

Just as with the standard documents included with your Magaya system, a 
custom document can be available for your customers to see via Magaya Live-
Track or sent via Transaction Tracking.

The Document Designer is included with all Magaya software. It can be opened 
a few different ways: from your computer’s Start menu > All Programs > 
Magaya software, or from the Actions button when you’re viewing a document. 
See the section below on related topics to learn more about opening and using 
the program.

Administrative rights are needed to access the Document Designer program. 
Only users with administrative rights can publish templates.
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How Does the Document Designer Work?

The Document Designer uses visible elements which include graphic elements 
and controls:

• Graphic Elements: These include images, text boxes, lines, rectangles, and 
other shapes. You can fill the shapes with color, change the border or the 
font, etc.

• Controls: Controls are the way that the Document Designer displays the 
data. There are three types of Controls: edit boxes, checkboxes, and grid 
(tables). The Controls are linked to fields. The fields store the data, and 
Controls display the data. Examples of data include name and address of 
a consignee or agent, item descriptions, dates, etc. 

Let’s look at some basics about the Controls:

The following image shows a Control created and added to a document 
template using the Edit button (not the “Edit” menu option on the top toolbar).

When a Control is created using the Edit button (or using the checkbox or table 
buttons), the Control is “unlinked,” meaning it is not associated with any data 
source yet. It must be linked so data can display in it.
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To link this box with a data source, right-click on it and select “Properties” from 
the pop-up menu. On the Data tab, select a field name from the dropdown:

The field name needs an x-path that will lead to the data source for this field and 
populate it.

You can also create a Control and then drag an element from the Schema list 
and place it inside the Control box. The elements in the Schema list already have 
data sources associated with them. When you drag and drop an element from 
the Schema list, the field name is created automatically and linked to the 
Control.

To identify the Controls, add a label such as a text box. For example, if you are 
creating a document that a customs agent needs to fill out, you must add fields 
and labels so the agent knows where to write the date, etc. This image shows a 
shaded text box above the control:

You can also double-click a shaded text box and type in text.
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The Control that is associated with a field will gather data and display it. Fields 
have a field name, a data source type, and the data source itself. The following 
shows the field properties for an element dragged from the Schema list:

Controls can be snapped to the grid to align them.

Fields can be filled with data in these ways:

• From an XML element (in a schema list): This takes XML data from the 
current transaction such as a WR and fills it into the field.

• From a Formula: A Formula gets data from other fields through variables.

• From a Script: The script gets data from the DatabaseObject or the XML 
DocumentObject. (For example, you can access an item inside a shipment 
and calculate charges for that item based on the WR for the item.) For 
more details about using JavaScript, see the link to topic in the section 
“Related Topics” below.

• From User Input: A user enters text in an empty field that you create. This 
option is useful when the element you need is not in the schema list or 
when you need the flexibility to allow users to enter information.

Fields can be string fields for entering text, Boolean fields to create checkboxes, 
or table fields. When Magaya Explorer fills in a document, it takes all the infor-
mation entered in the dialog boxes and prepares it in an XML format. The fields 
each have their own x-paths (a unique XML path) that leads to this field and no 
other. Unused fields can be deleted by right-clicking on them.

For more about working with the elements in the program, see the section 
below for more topics, including learning about the program interface.
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The following diagram identifies the visible elements and the data elements, and 
it illustrates the relationship between the controls and the fields.

Controls are filled by fields, and fields are filled by the four data source.

Related Topics

To get started using the Document Designer, see the following documents to 
learn how to open the program, navigate the interface, and use the features:

• To learn how to open the Document Designer, see the article:

How to open the Document Designer: 

http://knowledge.magaya.com/#/article/open_document_designer
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• How to navigate and use the interface, toolbars and functions, see:

Use the Document Designer Interface: 

http://knowledge.magaya.com/#/article/interface_document_designer

• To see how to create a new template that you can customize from a blank, 
see:

Create a New Custom Template:

http://knowledge.magaya.com/#/article/create_new_template

• To see how to copy and existing template and edit it, see:

Customize an Existing Template: 

http://knowledge.magaya.com/#/article/customize_existing_template

• See how to add your company logo or other image to documents:

Add an Image or Logo to a Template: 

http://knowledge.magaya.com/#/article/add_image_logo

• See how to add custom fields so they display in documents:

Add Custom Fields to a Template:

http://knowledge.magaya.com/#/article/add_custom_fields_to_template

• Learn how to customize an existing label:

How to Customize a Label:

http://knowledge.magaya.com/#/article/customize_labels

• Learn how to add JavaScript code in documents:

JavaScriptinthe Document Designer:

http://knowledge.magaya.com/#/article/javascript_document_designer2

• See how to publish a template so it can be used in your system:

Publish a Template:

http://knowledge.magaya.com/#/article/publish_template
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How to Open the Document Designer

How to Open Magaya Document Designer

There are different ways to open the Document Designer:

1) The Document Designer can be opened from the server computer’s Start 
menu:

Notes: The Start menu will have a different appearance, depending on 
your operating system version.

Administrative rights are required to edit and save documents. The docu-
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ments are saved in the “Forms” folder of the application. If you launch the 
application from the Program Files folder, you need Windows permis-
sions.

2) The Document Designer can be opened when you’re viewing a transac-
tion such as a Shipment in Magaya Explorer:

Click the Document button (“Docum.”) on the toolbar on the top of the 
Magaya Explorer when viewing a shipment, or click on the Add Docu-
ment button (“Add Doc.”) on the Shipment Toolbar. A dialog box called 
“Select Documents” opens.

To open a new document, click “New.”

To copy an existing document and modify it, click the document name in 
the list and click the “Copy” button. (If the buttons are grayed out, verify 
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your rights access to the Forms folder on your computer.) Look for your 
document in the “Filename” column:

3) If you are working in the document view of a Pickup Order, Warehouse 
Receipt, or Cargo Release, click the arrow on the side of the Actions button 
and click “Select Template”:

A dialog box opens with buttons for you to select the template. Click New, 
Edit, or Copy.

The Magaya Document Designer opens:

• If you clicked New, you will see a dialog box with different types of 
templates you can choose from to make a new template.

• If you clicked Copy, you will see the template of the form you 
selected such as a WR or Pickup Order. When you copy a document, 
the Document Designer program saves it in the “Forms” folder.
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• To continue working on a document that you started but did not 
publish yet, select it from the list and click the “Edit” button.

Note: When you’re done editing, publish the document and make it 
available for all users in the company by downloading it. For details, 
see the Knowledgebase article:

How to Pubish a Document

http://knowledge.magaya.com/#/article/publish_template

If you receive an error message when your try to download a modified docu-
ment, then you need Windows Administrator rights.

Related Resources

To learn about working with the Document Designer interface, see the topic:

Document Designer Interface

http://knowledge.magaya.com/#/article/interface_document_designer
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Navigating the Document Designer

The Document Designer Interface

The main screen of the Document Designer contains the Design/Code pane, 
toolbars, menus, and schema list.

The Design pane will display the template you are working on.
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The Code pane will display any JavaScript code you have created for the docu-
ment.

The Code view pane includes line numbers to find and correct an error when 
you run the Script > Check Syntax process.

Learn more about using JavaScript with the Document Designer in the 
following Knowledgebase article:

JavaScript in the Document Designer:

http://knowledge.magaya.com/#/article/javascript_document_designer2
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Toolbars and Menus

The toolbars on the top of the Design pane include standard buttons such as 
Save, Edit, and Zoom.

To add graphic elements, use the buttons to draw a line, rectangle, circle, text 
box, or add an image.

To add your company logo, click the “Logo” button and then click the location 
on the document to place the logo. Drag the corners of the image to size the logo 
placeholder frame. As a result, the location of the logo is saved. When you 
upload the logo into your Magaya Explorer Configuration > Company Type 
menu, the logo will display in the placeholder. Learn more in the following 
Knowledgebase article:

How to Add a Logo to a Template:

http://knowledge.magaya.com/#/article/add_image_logo

To add a Control, use the control buttons to create an Edit box, a checkbox, or 
a table. The choice of Control will depend on how the box will be used in your 
document. (Remember: Controls display data from fields in your Magaya 
system.)

The toolbars can be moved around by clicking and dragging them.

In addition to the toolbars, the menu commands across the top offer many func-
tions:
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• The Insert menu contains many of the functions that are also available as 
buttons on the toolbar such as the line or rectangle buttons.

You can also add a background image which will look similar to a water-
mark. The background image format must be an Enhanced Metafile 
(.emf), a Microsoft specific vector graphic file format, which can be 
created in Microsoft Visio, PowerPoint and some other programs.

• The Script menu option is active when you are working in the Code pane. 
It is grayed out when you are working on the Design pane. The Script 
menu contains options to check syntax and more.

• The Window menu has options such as the ability to switch between 
viewing different documents if you are working on more than one.

• The Layers menu includes options to view the Drawing Layer and the 
Control Layer:

- The Control Layer is the layer of the template you see in the Design pane 
that contains only the Controls and fields from the schema list or any 
Controls you added using the Control buttons.

- The Drawing Layer shows the text boxes, rectangles, lines, etc. added to 
a template. Both layers are displayed and enabled by default. When you 
view the Layers menu, you will see a checkmark next to the layer(s) that 
are displayed. 
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Tools to Add New Fields to a Template

On the right side of the Document Designer interface is a panel with three tabs: 
Schema (XML), Fields, and Variables. These are the elements you will use to 
create new fields on your custom template.

The schema list is specific to the type of template you are creating, and it shows 
all the elements available for that type of transaction. For example, if you want 
to create a shipment document, then the list of schema will include all the 
elements related to shipments such as the carrier, charges, destination, etc. 
These elements can be dragged and dropped from this list to the Design pane.

Let’s look at each one in the sections below.

Schema

The schema are XML elements used to feed data into fields. When you drag and 
drop one of these elements from the schema list to the template in the Design 
pane, a control and a field that will fill with data are created. (The fields created 
can be viewed by clicking on the “Fields” tab on the bottom of the Schema list.)

The schema list shows all the elements available for the type of transaction you 
are working on such as a Warehouse Receipt or Shipment. For example, if you 
drag the element “Number” from the list and drop it on the template, it creates 
a field for the shipment number. When a user enters the shipment number (or 
name) in the shipment dialog box in Magaya Explorer, it will appear on the 
form in the place you specify with Document Designer.

For specific information on each element in the schema, hover the mouse over 
each element to see a pop-up with details.
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To expand one of the elements, click on the plus sign. This will show all the 
sub-elements inside that element.

Fields

Fields store data. The data can be filled in automatically by linking the field to a 
schema element, or the user can fill in the data by typing information into the 
control associated with that field.

The fields you see in the list are the fields that come with your documents by 
default. They can also be created by the system automatically when you drag a 
schema element from the Schema list to the template.
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You can also add different types of fields if you do not see the one you need. 
Click the Add button and select the field type: String, Boolean, or Table:

Other buttons enable you to view properties or delete a field.

The columns in the list show the field name, type, and source type:

Variables

Variables are often used to calculate totals in formulas by gathering data from 
other fields such as the total of prepaid charges in an Air Waybill (AWB).
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When you click the “Add” button in the Variables list, a dialog box opens. In the 
dialog box, the dropdown arrow for “Field” will show the fields used in the 
custom template you are designing.

The name (alias) is filled in when you select the field. To treat null as zero, check 
the box: This will make sure no value is calculated if a field is blank. The Column 
field is used if you have a table (or a grid) and want to specify the column for the 
variable.
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For each Control created in a template, you can create a caption or a label for it 
by using the text button to add a text box to the template.

You can copy a text box and paste it by right-clicking on the text box and 
selecting “Copy” from the pop-up menu. (Alternates: Use “Edit” on the menu 
or press the Ctrl + C keys on the keyboard.)

When you select the box, it will have handles (boxes on the edges) that you can 
use for resizing.

Text wraps inside a text box.

In addition to the Design pane in Document Designer, there is a Code pane that 
can be used to enter code to create custom fields on a template. The Code pane 
is similar to a text editor.
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Document Properties

The document’s properties are accessible from View > Document Properties.

In the dialog box that opens, you can see the properties such as the name and 
language on the “General” tab.
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The “Options” tab includes options such as if you want to automate numbering 
and if the document is obsolete. If you mark a document as obsolete (inactive) 
then the document will not be available in the list of documents in your Magaya 
system.

Check any options that apply. Save and publish the template when finished.
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The “Details” tab includes a place for you to enter keywords and other details to 
help identify documents and search for them more easily in your Magaya 
system. Enter data here, save and publish the template.
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To define copies, go to the “Types of Copies” tab.

Click the “Add” button to open a dialog box where you can define the types of 
copies you want and how many. (To show the copy type on the document, add 
it to the template. For example, you may want this information at the bottom of 
the page near the signature. If you don’t want to display a name to the type of 
copy, then don’t add a control field in the template.)

Note: When printing a document, the number of copies printed will be what is 
defined here in the template. The Print dialog box will show the range of pages, 
including copies.

Save the changes to the template, and publish it.

Any template you publish is automatically available in your system of the 
computer that saved it. If you create it on one computer and want another user 
on a different computer to access that document, they need to download it into 
their Magaya system by following these steps:

Go to your Magaya system to download a document:
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• Go to File > Download Document

Note: If you receive an error message when your try to download a modi-
fied document, then you need Windows Administrator rights.

• Set the filter criteria as needed in this Download window. The list displays 
all available documents, both customized and standard. (Note: These 
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criteria are the ones saved in the Document Properties in the Document 
Designer program.)

The list shows you what type of documents are available, if they are newly 
published, which version (the “Version” column tells you the version 
number of the latest version; the “Published Version” column tells you 
what you have published in your system.).

Learn more in the topic “Publish a Template”

How to Publish a Template:

http://knowledge.magaya.com/#/article/publish_template
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Document Properties and Printing from Magaya Explorer

To view the properties of a document from Magaya Explorer, click the “Proper-
ties” button in the toolbar on the top of a document.

In the dialog box that opens, the document properties are displayed, including 
the template name, paper size, layout and version number.
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Print on Pre-Printed Forms:

To print the document on pre-printed paper, check the box.This will gray out 
(deactivate) the other fields in the box. Use this option to print the fields only, 
not the other lines, etc. on the form.

To print all the lines and the data in the fields, leave the box unchecked. The 
other options are:

• Use actual template size: This will not stretch the design regardless of the 
paper size selected for printing. (Recommended)

• Fit document to printer margins: This will stretch the design to the print-
able area, ensuring the document will be printed correctly, even if the 
template design is very close to the paper edges.

• Fit document to printer paper size: This will stretch the design to the 
selected paper size.
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Insert Barcode Font

To insert a barcode into a table of a document, click the table where you want to 
insert the barcode, right-click it and select “Field Properties.” In that dialog box, 
on the Columns tab, checkmark the option “Barcode.”

Note: If the menu is grayed out when you right-click on a table, click the button 
on the toolbar for “Selection Tool” (it looks like an arrow icon).

To insert a barcode into an Edit Box, right-click the box, select Properties, and 
go to the “Text” tab. Check the box for the Barcode.

Click “Apply” to see the barcode in the document.
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Additional Formatting Tips

Thousands separators: The system adds a comma to numbers in the thousands, 
for example: 1,200. If you want to turn this off, in the Document Designer, click 
View > Document Properties and go to the “Options” tab. Check the box “Do 
not apply formatting to numbers.” This setting is per computer.

To move multiple fields at the same time, select them all and then move them.

Controls can be moved so that they snap to the grid. This helps align them.

When inserting an image, the aspect ratio is maintained when resizing the 
image.

To add pages to a template, click the “Add” button in the “Page Template” pane.
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Customize a Template

Overview to Customizing an Existing Template

Existing templates can be modified to your needs. You can add or remove fields, 
insert an image or your company logo, add pages to the template and design a 
new layout for each page, and make other changes.

Admin rights are required to save and publish templates.

Maximum file size for a template is 600 KB.

Plan Your Custom Template:

To get started with your custom template, evaluate what you need to do. For 
example, you may want to add text such as “Hazardous Materials” in bold red 
letters across the top of a Warehouse Receipt (WR), or maybe you need to add 
information into the WR about vehicles that you ship. You can also add infor-
mation collected in custom fields that provide more information on the type of 
hazardous materials or vehicles in a shipment. These fields can be added to the 
WR. The custom WR template can be added to the list of templates users can 
choose from.

Open the Document Designer:

To customize a template, open it - either from the Start menu or from within 
Magaya Explorer (in a transaction such as a WR document > Actions > Copy). 
The Document Designer will open the template and display it in the Design 
pane. Rename the template and save it in the Forms folder inside your Magaya 
software installation folder.

Common Functions for Customizing and Editing Templates:

The following explains some of the more common functions in the Document 
Designer program that are used for customizing and editing templates.
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Alignment: To align elements, select them and click on the Align button in the 
toolbar. (Alternate method: Select all and right-click, go to “Shape”.)

Resize Multiple Fields:

To change the shape of fields, you can select one or more fields and right-click 
on them to access a pop-up menu. The following screenshot shows three fields 
selected and the pop-up menu with the “Shape” command selected to make the 
three fields the same width:

This will make all the selected fields the same width, so you do not have to resize 
each one separately. You can also align fields by using the Align buttons on the 
toolbar.
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Fonts

To change the font or other properties of the text box, right-click on the text box 
and select “Properties” (or use the buttons on the Font toolbar). A dialog box 
opens. Go to the “Text” tab:

Checking the checkbox “Embedded into the document” will increase your file 
size. If you need to reduce the file size, ensure this box is unchecked.

When you create a text box or drag a schema element to the design pane, you 
will need to click on the Selection Tool button (the arrow icon) to access the 
right-click menu options such as the Properties.

The Object Properties box contains choices for changing the font, alignment of 
the text inside the box, and margins.

A font can also be a barcode. See following Knowledgebase article:
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How to add a barcode to a template:

http://knowledge.magaya.com/#/article/interface_document_designer

To access the properties of the control, right-click on the control and select 
“Properties.” A dialog box opens with three tabs:

The General tab shows the name of the object as assigned by the system. Choices 
are available for:

- Printing: Check the box to print the field. Check the box to print the field only 
on the last page of the template.

- Behavior: What do you want these fields to do? Let’s look at the options:

- Add page numbers.

- Check the option for “Multipage” if the field could go to more than one page, 
such as a long table of commodities, for example. Check this to ensure all the 
data is included, regardless of how long it is. If not checked, then the data will 
end where the table ends on the page. If the template only has one page, and you 
check this, the data will fill in on the second page, but the second page will have 
the same layout as the first page. If you want to create a different layout for 
multiple pages, use the “Add” page function in the “Page Templates” pane, and 
create the layouts.

- Check Multiline if a field will have more than one line. This is often used for 
addresses that have more than one line of text.

The Text tab has the same fields as the Object Properties box such as font modi-
fications.
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The Data tab shows the field name and its properties such as the x-path of the 
field (the Data Source). X-path is a unique XML path that leads to this field and 
no other.

Tables

To create a table, click on the element you need such as Charges. The element 
has a table icon:

Click and drag the Charges element to the Design pane. It will appear as a box 
with the word “Charges” inside it.

To add cells to the table, right-click on the field to access a pop-up menu. For 
example, if you need a table with the Description, Value, and Currency, then 
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create a table with three columns to collect this data. Select “Create Record Defi-
nition”.

This will add cells (columns) in the Charges table:

Add text boxes for the column names.

You can click and drag on the column lines to adjust the width of each.
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To add more rows of cells, right-click on a cell and select from the pop-up menu:

For additional table properties, right-click on a table and select “Field Proper-
ties” from the pop-up menu. In the dialog box, click on the Columns tab and set 
the column properties:

Also available in this Table Field Properties dialog box is the option to add a 
dropdown list to a form: Click on the “Selection Type” dropdown.
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To add a table header, click on the Rectangle button on the toolbar.

Draw the rectangle above the table. To access the properties of the rectangle, 
click on the Selection tool button (the arrow) and then click on the rectangle. 
Next right-click on the rectangle and select “Properties” from the pop-up menu. 
Use this menu to choose fill color and border lines.

To add more columns to a table, right-click on an existing column to access a 
pop-up menu of choices such as “Add column to the right”, etc.
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To add fields to the table such as charges and the information about the charges, 
select the schema you want in the table and drag them to the table.

The Magaya Explorer gathers many pieces of information about shipments and 
their charges. With the Document Designer, you can create a custom form with 
the shipping charges you want to show in the form.

Add a Page to a Template

If you would like to add your terms and conditions to the back of a document, 
you can do it by adding a page to a template. Templates can have as many pages 
as you need. Perhaps you want to have a longer Quotation document; you can 
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continue to the list of items to a second or third page. Each page can have its own 
layout.

To define copies, go to the “Types of Copies” tab.

Click the “Add” button to open a dialog box where you can define the types of 
copies you want and how many. (To show the copy type on the document, add 
it to the template. For example, you may want this information at the bottom of 
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the page near the signature. If you don’t want to display a name to the type of 
copy, then don’t add a control field in the template.)

Note: When printing a document, the number of copies printed will be what is 
defined here in the template. The Print dialog box will show the range of pages, 
including copies.

When you’re done editing, save and publish the document template (admin 
rights required). The download it into your Magaya Explorer so it’s available to 
use. See:

How to Publish a Document:

http://knowledge.magaya.com/#/article/publish_template
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Add a Logo

Overview: Add an Image or Logo to a Template

You can add an image or your logo to a template. This example will show how 
to add a company logo to a template for a Magaya document.

The maximum file size for a logo graphic file is 300 KB. The total size of the 
document, including the logo, cannot exceed 600 KB. If it is larger, it can’t be 
uploaded to your Magaya system. Only users with administrative permission 
can publish templates.

The preferred file format is .png or .jpg files.

These steps can be used for inserting any image. This article will also show how 
to add other images, not logos.

Overview: To insert a logo, there are two main steps: 1) Upload the image file to 
your Magaya Explorer Configuration menu, and 2) create a placeholder in a 
template using the Document Designer. Let’s start with uploading the graphic 
file of the logo into your Magaya Explorer.
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Upload your Logo

Upload the logo to your Magaya Explorer.

1) Go to the Configuration menu > Company

2) Click inside the “File name” field and click the “Browse” button.

Navigate to your logo file and upload it.

3) Save.

Note: After saving this logo configuration, the logo will automatically display on 
the LiveTrack login page if you have LiveTrack on your website. Learn more:

Customize LiveTrack

http://knowledge.magaya.com/#/article/livetrack_customize
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Insert a Logo Placeholder into a Template

1. In the Document Designer, click the “Logo” button and then click the place 
on the template to add the logo. Click and drag the corners of the logo place-
holder to the size you want. Save and publish the template.

2. In your Magaya Explorer (from the server computer or the computer where 
Magaya software was installed), click File > Download Document. Find and 
save the document to your system.

3. Then go to the transaction type that you customized in the Document 
Designer. From the document view, click the Actions button > Select Template. 
Find the template, select it and click the checkbox to link the selected template 
to this transaction. Click OK to save.
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The logo file is saved on the Magaya servers so it can be easily transmitted when 
documents are sent through the Magaya Network. If you change your logo, any 
older documents sent to other users will retain the old logo. The new logo will 
appear on all new documents sent.

The logo will also appear in LiveTrack on the login screen when your LiveTrack 
URL includes your company’s Magaya Network ID.

For more on modifying your LiveTrack URL, see the following Knowledgebase 
article:

Customize LiveTrack:

http://knowledge.magaya.com/#/article/livetrack_customize
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Insert an Image (not a logo)

1) Click on the Image button (or click on the Insert menu and select Image):

2) Draw a box on the document where you want the image to appear. A 
dialog box opens.

3) Select your image file from your folder.

4) Click OK to insert the graphic.

To adjust the size or shape of the box, click on the Selection tool on the toolbar 
(the button with the arrow). Squares will appear on the corners of the image 
box. Click and drag from any square to resize the image. The aspect ratio will be 
retained when resizing.

The image will be fit into the space of the box, stretching the image if needed. 
To turn off this stretch feature, right-click on the image and select “Image” and 
select “Stretch” to uncheck the option. Another option in this menu is “Image” 
and “Adjust control to image.” This option will display the image in its original, 
full size.

Save the file by a unique name. Remember the name when you’re publishing the 
document template later. You can also add more details in the Document Prop-
erties dialog box, which is available from the “View” menu.
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To delete the image, click on the Edit menu and select Undo Insert (or select the 
image and click the Delete key).

Save the template when you are done. (Tip: As with any document you are 
working on, it is best to save periodically while you are working.)

If you need help with the buttons, toolbars or other elements of the interface, see 
the topic:

How to Navigate the Document Designer Interface:

http://knowledge.magaya.com/#/article/interface_document_designer
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Customize a Label

This topic explains how to customize a template for a Magaya label using the 
Magaya Document Designer.

Edit an Existing Label

To edit an existing label, click the “Open” button in the top menu of the Docu-
ment Designer.

All labels can be found in the Forms folder of your Magaya software:
241



Customize a Label Chapter 5
Select the label you want to edit, for example the “WMS4x6” and then save it 
under a new name. Remember this name because you will need to find it later.

Standard labels available to be edited include:

• Receiving labels: These file names start with the letters RCV and include 
the label size such as 4x6. The label file “RCVTrack4x6” prints labels when 
a user submits an online pickup order. It can be found in the Configura-
tion menu for Online Shipping Orders of your Magaya Explorer.

• Shipment labels: Master (mshp) and House (hshp)

• Cargo Release labels: Have the letters “CRL” on the label file name. These 
labels can be found when viewing a Cargo Release > Print Labels.

• Courier 4x4 label. Available from the Shipment’s “Print” button in 
Magaya Explorer.

• WMS labels: Also available from the Warehouse Receipt “Print” button.
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Edit the label using the menus, buttons, and right-click functions. Add a logo 
placeholder with the “Logo” button.

JavaScript code can also be used to add custom information to the label. For 
example, if you want to load the Shipper, Supplier, or other information from 
the Warehouse Receipt, use JavaScript code to make a call to the database to 
retrieve the details and display them at the Item level. This requires program-
ming knowledge and administrative access to your Magaya software.

For full details on working with the Document Designer, see the section below 
“Additional Resources.”

If you need help with code or customizing, Magaya Corporation provides paid 
services to customize documents and labels. Contact Magaya for more details.

Create a New Label

To create a new label, open the Document Designer by clicking the Actions 
button from a document view such as the Cargo Release.

Click “Select Template.” A dialog box opens.

Click the “New” button.
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The Document Designer opens. Select the template of the label type you want.

Name the label and click “OK” to open it in the Document Designer. You can 
add fields, a bar code, a logo and more.

After editing the label, save it and publish it.

In your Magaya Explorer, click File > Download Document to make the label 
available in your system.

Examples of Labels:
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This is an example of a label with the Warehouse Receipt number on it (2075):

Also on the label is the location of the item, which piece of the total pieces, a 
description and more.
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The following label is a Cargo Release label:

This label shows the carrier, who the item is being released to, and more.

Additional Resources

For help using the Document Designer, see the Getting Started article in the 
Knowledgebase:

Getting Started with the Document Designer:

http://knowledge.magaya.com/#/article/intro_document_designer
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Add Custom Fields to a Template

If you added Custom Fields in Magaya Explorer, then you can make the data 
gathered in those Custom Fields appear in the document. (Custom Fields can 
be added in the Maintenance folder > Configuration > Custom Fields.)

Custom fields may be used to gather data on transactions such as a Warehouse 
Receipt (WR). If you ship vehicles, for example, you may need to know if the 
title or keys are with the vehicle.

First create the custom field in Magaya Explorer, and then add the custom field 
to the WR document template. Tip: Remember the “Internal Name” assigned to 
the custom field. You will need it when you are working in the Document 
Designer.

To add a custom field to a template such as a WR, go to the WR document and 
click the “Actions” button.

1) From the Actions button’s dropdown menu, click “Select Template”.

2) Select a document template from the list and click the “Copy” button.

3) Rename the file and save it in the same folder as the other document 
templates: the Magaya software Forms folder (in the same place your soft-
ware is saved, usually).

When the Document Designer application opens, follow these steps.

• Make room for the new field in the template by clicking and dragging on 
an existing box so there will be a space for the new field.
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• Expand the element “Custom Field” by clicking on the plus sign.

• Drag the sub-element <new field> to the Design pane into the space you 
created on the template. A dialog box opens:

• Enter the Internal Name of the custom field. The Internal Name is the 
name assigned by Magaya Explorer when you created the Custom Field in 
the Maintenance folder. (Important: Use the same internal name or the 
Magaya system will not find the data.)

This custom field will populate with data from Magaya Explorer. You can add a 
caption (or label) to this custom field to identify it. For this example, the label 
could be “Is the title with the vehicle?” The answer field can be a dropdown or a 
text field to enter Yes or No.

To add text to the text box, click the Arrow button on the toolbar and then 
double-click the text box to activate it.

To make the field display the way you want it to, right-click on the field and 
select Field Properties > Format > Boolean.

Note: If you have the transaction document open in Magaya Explorer while you 
make changes in the Document Designer, you will need to reload (update) the 
data into the form to see the custom field. To reload, right-click on the docu-
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ment name in the folder list in Magaya Explorer. From the pop-up menu, select 
“Update Document”:

Page numbers can be added by adding a new Edit Control. In the Properties, 
check the option for page numbers. The system will automatically output “Page 
1 of 5” for example.

Here is an example of a Cargo Release with a Custom Field added to gather 
information required by the TSA (the U.S. Transportation and Security Admin-
istration):
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1. Create the Custom Field.

2.This is how the Custom Field looks in the CR dialog box (on the Custom tab):
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3. This is how it looks in the document when you select that template:
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Create a New Custom Template

To create a new template when you are working in the Document Designer 
program, click on File > New. A dialog box opens:

• Select the type of template you want to create.

• Enter a document name. The “File Name” field will automatically update 
with the new name.

• Save the template in the Forms folder in the Magaya software folder.

• Select the language.

A blank document opens.
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Drag and drop the fields you want from the schema list to the Design pane.

Additional Resources

Add lines, backgrounds, text boxes, etc. by using the buttons on the toolbars are 
explained in the following Knowledgebase topic:

Customize an Existing Template:

http://knowledge.magaya.com/#/article/customize_existing_template
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Publish a Template

Publish a Template

To publish a template, requires two major steps:

1) Publish the Document in the Document Designer program

2) Upload it to the Magaya Explorer

NOTES: Administrative rights are needed to publish a template. Maximum 
document size is 600 KB. The “template” is also referred to as a “document 
template.”

Follow the steps below, beginning in the Document Designer program:

1. Publish in the Document Designer:

1) Click File > Publish Document in the Document Designer.
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The dialog box displays your Magaya Network ID and company name automat-
ically. If you are working remotely, the company name will not fill in to the 
Publish fields automatically. Type in the data.

To change the document name, click the “Properties” button. Enter a name. 
Return to the publishing dialog box.

Click the “Publish” button.

NOTES: If a document is over 600 KB, the program will not let you publish it. 
You will get an error message stating the document is too large and must be 
resized to be published. Try resizing images to reduce the file size.

2. Download the Document into Magaya Explorer:

Download the document from the “File” menu of your Magaya Explorer.
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Look for your document in the list of Custom Documents.

Look at the version number for the file. Scroll to that column in the dialog box. 
The column “Version” displays the number of the latest version available. The 
column “Published Version” displays the version on your system.

You can use the filters to help find a document or enter keywords in the "Free 
text" field. These filters are pulled from the criteria defined in the Document 
Properties in the Document Designer program. For more on Document Prop-
erties, see the following Knowledgebase article:

Navigating the Document Interface:

http://knowledge.magaya.com/#/article/interface_document_designer

Any template you publish is automatically available in your system of the 
computer that saved it. If you create it on one computer and want another user 
on a different computer to access that document, they need to download it into 
their Magaya system. If you receive an error message when your try to download 
a modified document, then you need Windows Administrator rights.

The template is now available in Magaya Explorer for users. If you created it and 
saved it in the Forms folder on your computer, then you don’t need to get it. It 
will be available immediately. If you want another user on a different computer 
to access it, they will need to go to File > Download.
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General Information about Downloading Documents: You can use this File > 
Download Document method any time there is a new document released from 
Magaya Corporation or when a custom document is created for you.

- A document or label with a green arrow indicates that an update was made to 
that file. Download it to get the latest version.

- A document or label with a yellow star indicates this is a new document that is 
not downloaded yet into your Magaya Explorer.

The template can be used by selecting the template from the Actions button (or 
the “Document” button in a shipment).

Note: If you have custom documents, verify them after each software update to 
ensure all the fields display correctly. If you have questions, please contact 
Magaya Corporation.
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JavaScript: in Document Designer

While the Magaya Document Designer program offers many drag-and-drop 
options to customize documents, sometimes you may need to write JavaScript 
code for additional functionality.

This topic will explain the tools Magaya provides when you are programming 
inside your document. Magaya has chosen the JavaScript language which 
includes functions, loops, conditions, and more.

In addition, the JavaScript function in the Magaya Document Designer has two 
added objects that enable you to access the data you need: XmlDocument and 
Database objects:

• The XmlDocument object contains many properties and methods that 
help you code in Magaya Document Designer.

• The Database object allows you to query the Magaya Database for infor-
mation not present in the XML transaction. For example, you can use this 
object to pull a full warehouse receipt, a shipment, invoice, or any other 
transaction from the database with a single call.
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Enter Code into Magaya Document Designer

To enter JavaScript code in the Magaya Document Designer, click on the Code 
button on the taskbar and begin entering code.

Select the Data Source: Right-click on the Control and select Field Properties. 
Click on the “Data source” dropdown menu to select a function you made. If 
you have not created code yet, you can create a placeholder function by clicking 
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on the “New” button in the dialog box, and type the name of the function. Then 
you can fill in the details of the code later.

Check Syntax: To check the syntax of code, click on the Script menu on the top 
of the Magaya Document Designer interface. Select “Check Syntax” from the 
dropdown menu:

Insert Initialization function: Use this function to load data that will be used 
frequently inside the document to optimize speed.

Insert Finalization function: Use this function to clean up any resources allo-
cated at Initialization while working in the document.

Save (File > Save) and publish the document when you are done (File > Publish 
Document).
261



JavaScript: in Document Designer Chapter 6
Additional JavaScript Resources

To learn more about using JavaScript in the Magaya Document Designer, 
including more details on the xmlDocument Object and the Database object, 
and some examples of JavaScript, please see the Customization user manual in 
PDF on the Learning Center, available from Page One:

For JavaScript basics, see the following Knowledgebase article:

JavaScript in the Document Designer: 

http://knowledge.magaya.com/#/article/javascript_basics
 262

http://knowledge.magaya.com/#/article/javascript_basics


263

Chapter 7 7. Divisions

7. Divisions



Chapter 7 Divisions
Divisions

Introduction to Divisions

Your company may have different divisions. They can vary based on the type of 
shipping done; perhaps you have one division of employees handling exports 
and one for imports. Your company many have different divisions in different 
cities. Other companies may have a division that handles all the ocean ship-
ments and one that handles all the air shipments.

In Magaya Explorer, you can assign divisions according to your needs. Each 
division can have a separate address and contact information. Then these divi-
sions can be used in transactions such as Cargo Releases, Shipments, and more.

Step-by-Step Procedure: Set Up Divisions

Divisions can only be set up by a person with administrative rights.

1) Go to the Maintenance folder in Magaya Explorer.

2) Click on Configuration.
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3) Select “Divisions” from the vertical menu (you may have to scroll down).

Note: Divisions can also be set up in the Employees subfolder by clicking on the 
Actions button and selecting “Divisions”. A list opens. The menu on the list has 
an Add button. This is the same list and Add button that are available in the 
Configuration subfolder. The Divisions list is also available from the Actions 
button in the Chart of Accounts.
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Click the Add button. A dialog box opens. There are three tabs:

• On the first tab, “Division”, enter the division name.

• Enter the phone number, fax number, and email (optional).

• Select the default company. When you select a default company here, this 
company and its address will appear in transactions that use that division.

• Check the box if you want this division name to appear in documents such 
as Air Waybills or Bills of Lading.

• Add any comments as needed.

• Click on the Address tab and enter the address. This address will appear 
in the documents created by this division.

• Click on the US Customs Codes tab and enter the Air AMS Originator 
Code (if needed). This is used when filing AMS from the division.

• Click the OK button when you are done.

The Division will be added to the list.

In the Divisions list, you can choose the columns in the list by clicking on the 
Actions button.
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Assign an Employee to a Division

To assign employees to divisions, go to the Employee subfolder under the Main-
tenance folder.

Select the employee and double-click on their name (or click on the Edit 
button).

In the dialog box, click on the “User” tab.

• Select a division for this employee. To remove the division, click on the red 
x button; this will clear the dropdown field.

• If you want to restrict this employee’s access so they can only view trans-
actions from this division, place a checkmark in the box “Can only see 
transactions from this division.” This can also be changed at any time by 
unchecking the box.

• Click OK when you are done to save the settings.

Result: When the Administrator assigns an employee to a division, the employee 
will not see the Division dropdown menu in their transaction screens. The 
transactions that employee creates will be automatically assigned to that divi-
sion; there is no need for them to select the division. Documents created by that 
employee will automatically display the division name and address.
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Using Divisions in Transactions

After divisions have been created, they can be used in transactions such as this 
Cargo Release:

The Divisions dropdown is visible to a person who has Administrative rights in 
the Magaya System and who is not assigned to a division. When the Adminis-
trator assigns an employee to a division, the employee will not see the Division 
dropdown menu in their screen. The employee will not be able to change the 
division. The transactions that employee creates will be automatically assigned 
to that division; there is no need for them to select the division.

If you are an administrator who is not assigned to a division, you will see the 
Divisions dropdown on the General tab of transactions such as Pickup Orders 
and Warehouse Receipts, or you will see it on the first screen of a shipment 
wizard.

Divisions can also be assigned to entities such as Customers, Carriers, Agents, 
and Vendors and to warehouse zones in your Magaya system. Employees in a 
division will only see entities or warehouse zones in their division.
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This Cargo Release document below will show the “Ocean Shipments” division 
name and address, not the “Issued By” company name and address in the docu-
ment:

To limit what LiveTrack users see: You can limit a LiveTrack user to see only 
transactions from a specific division by right-clicking the Customer profile, 
selecting “Configure LiveTrack/Logistico Access” and checking the settings on 
the Restrictions tab.

Reports by Division

To create reports by division, go to the list you need to create a report about such 
as the Pickup Orders List or Warehouse Receipts List.

Click on the Actions button, and select “Reports”.
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In the pop-up menu, select “By Division”.

All the transactions for that division will appear in the report.

View Inventory Items by Division

To see the inventory per division, go to the Inventory Item Definitions list, click 
the “Detail” button, and select the panel “Inventory by Division.”
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Database Administration

Introduction: Database Administration

The Magaya Database Server Agent contains all the functions needed to manage 
your Magaya database, including tools to optimize your database performance, 
to create a backup of the database, and how to set up an automated backup 
schedule.

To access the Magaya Database Server Agent, right-click on the taskbar icon for 
the Magaya Database Server Agent (or double-click on it).

When you right-click on the icon, a menu pops up.

Select “Open Database Administrator.”
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A dialog box opens:

If the database is not running, click the Start button.

Working with the Magaya Database Server Agent

The dialog box for the Magaya Database Server Agent shows the following 
information about your Magaya database:

• The database computer number and the port for this database are listed on 
the top.

• The status of the database is noted on the top, for example, “Running” or 
“Stopped.”

• Database location: Where the data is located. To change the file location, 
stop the database first. The “Change” button is grayed out when the data-
base is running.

• Log File: This is a trace file of events such as who opened sessions and 
when, disconnections, etc. To change the file location, stop the database 
first. The “Change” button is grayed out when the database is running.
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• Connections: As you click on each tab, the computer name, user name, 
number of instances, and the application type that is running are 
displayed. The tabs are:

- Local Users

- Remote Users

- Other Connections such as the Magaya Communication Server Agent

- All Connections

• Refresh button: To refresh the view of the database by clicking the icon of 
the two arrows in a circle.

• Stop button: To stop the Magaya Database Server Agent. First all users 
must log off. If any users are connected when you click the Stop button, a 
notice will appear asking if you want to continue while they are open. This 
is NOT recommended. It will close their connection and could cause data 
to be lost. Do not stop the database while users are logged in.

• Start button: This will restart the same database.

• Backup button: To create a back up of your database, either a full backup 
or an incremental backup.

• Restore: To select another database. A window opens. Before using the 
Restore button, stop the database first.

• Options: This button opens a dialog box with options to set up a schedule 
to automate the database backup process and set the amount of memory 
you want the database to use.

• Tools: This button opens a dialog box to shrink the database. The database 
must be stopped. See the section on Database Performance for steps. The 
steps also include some settings needed in the Maintenance > Configura-
tion folder of your Magaya Explorer.

Additional Resources

As a database administrator, there are many other functions to learn about. See 
the following Knowledgebase article for an overview of admin functions:

http://knowledge.magaya.com/#/article/admin_overview
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Backups

The Magaya database can be backed up in full or in part (incremental).

Create a Full Backup of Your Magaya Database

Creating a full backup of your database is recommended before you perform an 
online update of your software or any time you want a backup of your data.

The Full Backup process will make a backup all your system data in contrast to 
an incremental backup, which creates a partial backup of only the data that has 
changed since the last full backup. For more on incremental backups, see the 
section “Create an Incremental Backup”.

To create a fullmanual backup, follow these steps:

1) Open the Magaya Database Server Agent by right-clicking on the Magaya 
Database Server Agent icon in your computer’s taskbar. (Alternate: 
Double-click on the icon to open it.)

2) Select “Open Database Administrator” from the pop-up menu.
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3) Click the Backup button.

Select “Manual Full Backup” from the pop-up menu.

A dialog box opens, showing your computer files.
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4) Navigate to the folder that you want to use as the location to save the 
backup (or use the default location).

The full backup file has an extension of .bak added to the end of the file 
name. The file name includes the date.

5) Click “Save”. The length of time required to save it depends on the size of 
your database. If the backup is unsuccessful, the system will notify you. If 
you need more space, consider deleting old files or placing them on 
another hard drive.

Best practices recommend saving your data on another hard drive or 
remote location to avoid loss of data if any damage occurs to the first loca-
tion.

Create an Incremental Backup

The Incremental Backups feature enables you to backup only the new transac-
tions and data since the last full backup instead of backing up the entire data-
base, which can take hours, depending on the size of your database. Incremental 
backups can be performed in minutes.
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To make your system perform an incremental backup now:

1) Open the Magaya Database Server dialog box from the taskbar icon.

2) Click the “Backup” button and select “Force an incremental backup now” 
from the pop-up menu:

3) The system asks if you want to perform this task. Click “Yes” to confirm it 
and proceed.
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The backup will be completed. Depending on the size of your database, the time 
for this backup will vary. Users can continue working during the backup. You 
may see a progress bar in the dialog box for the Magaya Database Server:

The incremental backup is saved in the folder with the most recent automated 
full backup.

The most recent, automated full backup is saved in this folder.

Note: A file extension .bk_ means the file is compressed, and .bak is not 
compressed.

Remember: You must also make a backup of the Blobs folder by copying it to 
another location. This will not be done automatically as of the publication date 
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of this documentation. The Blobs folder is located in the installation folder for 
Magaya software:

The Blobs files are unstructured data such as photographs or attachments. They 
are saved in a separate location from your database to help optimize the Magaya 
system. For details on optimizing your Magaya system, please see the section 
“Database Performance”.

Automate Database Backups: Overview

The Magaya Database Server Agent enables you to schedule automatic backups 
to occur when you want them to occur. You can automate full backups and 
incremental backups.

IMPORTANT: Set up the schedule on the server computer:

• Ensure the server computer will be on during the time that the backup 
is scheduled to occur.

For example, if you schedule an automated backup for 12:00 AM, then do 
not turn off the server computer overnight. It must be running to perform 
the backup.

• Ensure all users are logged off.
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Automate Full Backups

To set up your database to make a full backup automatically, follow these steps:

1) Click the “Options” button in the Magaya Database Server Agent dialog 
box.

Another dialog box opens called “Database Options”. It has a tab 
“Backups” that has the following functions:

• The checkbox for enabling automatic backups is checked by default. (If 
you do not want the backup to happen automatically, uncheck the box.)

• The Backup Path field shows the locations where the backup file will be 
saved. This computer must be on to perform the backup. Do not turn off 
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this computer. If you want to change the location, click on the button with 
the three dots.

• Select the frequency of the full backup: Every Day or Weekly (On Sunday); 
and set the time of day. 12:00 AM is recommended.

• Enter a number of the amount of past backups you want to save. The 
system will keep the most recent backups and delete the oldest backup file 
when it reaches the number set here. If you want to save a backup file for 
a longer period of time to keep a longer history, then increase the number 
here or copy that file into another file location. This automated process 
will not save all backup file indefinitely.

• Click the OK button to save your settings.

The backup file is saved in a folder with the date of the backup. The folder 
is saved in the location that is identified in the dialog box for the Magaya 
Database Server. Any incremental backups performed after this full 
backup are also saved in this folder.

Remember: You must also make a backup of the Blobs folder. This will not be 
done automatically as of the publication date of this documentation.

Automate Incremental Backups

1) Open the Magaya Database Server Agent by right-clicking on the icon in 
the taskbar.

2) Click the Options button in the dialog box.
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3) On the “Backup” tab of the Database Options dialog box, click the “Add” 
button under the Incremental Backups section of the screen.

In the dialog box, set the time for the incremental backup.
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4) Close the Time dialog box.

Close the Database Options dialog box.

The settings are saved, and the system will perform the incremental 
backup daily at the appointed time.

You must also make a backup copy of the Blobs folder. This will not be 
done automatically as of the publication date of this documentation.

Restore Data from a Backup File

To restore the data to your Magaya database, follow these steps:

1) Close your Magaya Explorer.

2) Right-click on the Magaya Communication Server Agent icon in the 
taskbar and select “Stop Communication Server”.

3) Open the Magaya Database Administrator Agent by right-clicking on the 
icon on the taskbar and selecting “Open Database Administrator”.

4) Click on the “Stop” button.

The “Restore” button will become active. It may take a moment.

5) Click the Restore button.
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6) Locate the backup file in the dialog box.

Backups are displayed in chronological order and are labeled as Full or 
Incremental. You can go back to a desired time, and the system will auto-
matically restore the Full backup and any Incremental backups since that 
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time. The full and incremental backups work together and depend on each 
other.

If files need to be decompressed, the system asks you if you want to 
decompress them now:

When the decompression is completed, the system shows you the result 
and asks if you want to continue:

Type “Yes” and click the “Finish” button.

If the system does not need to decompress files, a message will ask if you 
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are sure you want to restore the data from the specified file. Click “Yes”.

The database will restore and start again automatically.

7) Start the Magaya Communication Server Agent by right-clicking on the 
icon on the taskbar and selecting “Start Communication Server”.

Now you can open your Magaya Explorer.

Redundant Backup of Data

It's highly recommended to save the data on the premises of your business and 
at another location. This will prevent data loss due to theft or physical damage 
at your location such as water damage or fire.

An off-premises, remote backup, can be a portable hard drive that you take 
home with you every night, or cloud-based backup services from a third party. 
You may also store a portable hard drive in a fire-proof safe.

If you use a cloud backup service, you can send the data to them. If a major 
storm has damaged infrastructure such as power and Internet, you will not be 
able to access the cloud back up of your data until the utility company restores 
connections to power and other services.

Ensure you can access the data when you need it. This especially important for 
compliance regulations such as those from U.S. Customs. Having a procedure 
for backing up data is an important part of a disaster recovery plan.
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Database Performance

Magaya software version 8.5 and later includes features designed to help opti-
mize large databases. These are optional processes and not required for all 
Magaya customers. These optimizations are recommended if you have a large 
database with long lists of customers, carriers, vendors and other entities; 
numerous transactions such as Warehouse Receipts and other operations and 
accounting transactions; and many photographs or other attachments.

Improving the performance of your Magaya database is a multi-step process 
which begins with the following options in the Configuration menu:

• Recycling records

• Extracting heavyweight data to save it outside the database in a Blobs 
folder

• Shrinking the database

Please read ALL these steps carefully BEFORE beginning the optimization 
processes. The Recycling process is recommended to be done first. If you have 
questions, please contact Magaya Technical Support.

If you are updating your Magaya system from a version before 8.5, the update 
and optimization processes will require approximately 2.5 times the existing 
space. The space will be free after the optimization. Make a backup before these 
processes.

Recycling

The Recycling process helps keep the size of your Magaya database small by 
allowing you to set the amount of time you want to keep messages or transac-
tions in the database. When the timeframe is met, the items are moved out of 
the database. If you need them, they are available in the backup file.
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Perform the Recycling step before any other optimization steps.

1) Go to the Maintenance folder > Configuration menu.

Select “Maintenance and Performance”. This screen has a few sections, 
but this topic explains the functions in the “Recycling” section of the 
screen.

2) Check the box to “Allow the system to recycle the following records”.

3) When you check this box, the “Configure” button is activated. Click the 
Configure button. A dialog box opens.

4) In the dialog box, set the number of days you want to keep transactions. 
For example, you can set how long to keep transactions in the Transaction 
Log. The Transaction Log keeps a record of every transaction, including 
deletions. (For example, when an Invoice is deleted from the Invoice List, 
it is still saved in the Transaction Log, where it can be restored by 
right-clicking on it.)

When the Transaction Log is cleaned up, the transactions are removed 
from the Transaction Log, but they can still be accessed via the backup file 
if you need them later. Backup your data before cleaning up the Transac-
tion Log. It is important to clean up the Transaction Log to help reduce the 
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size of your database. To find the Transaction Log, click the “Options” 
button on the top menu of your Magaya Explorer.

5) When you click the “Save” button, the recycling process begins. The recy-
cling process will run in the background while users are working.

When the process is completed, the system creates a Task Alert to notify you, as 
shown in this example:

Click the “Set Completed” button in the Task Reminder dialog box and close it.

Extract Heavyweight Data to the Blobs Folder

Another way to improve performance is run a process to extract large files from 
your database and save them in a “Blobs” folder. The Blobs folder contains all 
the attachments such as images and PDFs that are attached to Warehouse 
Receipts and other Magaya transactions. These attachments are considered 
“unstructured” data and are saved outside the database in the Blobs folder. (The 
word “Blobs” refers to binary large object or basic large object.) The folder is 
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stored in the Program Files (unless your system is set up differently) in the 
Magaya Corp folder > Data. Here is an example:

When you backup your Magaya system, you must backup the Blobs folder sepa-
rately from the backup process. It is not part of the automated backup process 
as of the date of this documentation. To backup the blobs, go to the folder and 
copy it and save it in another location.

If you restore your database to another computer and do not copy the Blobs 
folder also, then the attachments will not appear in their transactions. If this 
happens, copy the folder to the new computer, and the images, etc. will be 
restored also.

Steps:

1) Go to the Maintenance folder and click “Maintenance & Performance”.

2) Check the box “Allow the system to extract heavy weight data such as 
images and data to an external File System Directory”.

This optimization will be applied to every transaction, current, future and 
past. The large files will be placed outside the database. The system creates 
a folder automatically in the Magaya software data folder.

The result of the unstructured data being stored in the Blobs folder is improved 
database performance. This is especially beneficial for companies with large 
databases that contain years of transactions and many MBs of photographs. 
Backups will also be faster.
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Shrink the Database

Another way to improve the database performance is to reduce (shrink) the size 
of the database. This process is done in two parts, one in the Maintenance 
screen, and another in the Magaya Database Server Agent dialog box.

The best time to perform this database shrink process is after unstructured data 
has been moved out of your database into the Blob folder and after you 
configure the Maintenance of your system to perform the Recycling processes 
as explained in the “Recycling” topic.

Follow these steps to shrink the database and gain performance improvements:

A. Shrink the Historical Data:

1) Go to the Maintenance folder and click “Maintenance & Performance”.

2) Check the box “Allow the system to shrink the size of historical data.” This 
will reduce the size of all legacy transaction files. This will go back through 
old transactions, not just current transactions moving forward from 
today.

3) Click “Save”.

When this process is completed, the system will notify you with a Task.

B. Shrink the Database:

1) Make sure all users are logged off.

2) Stop the Magaya Communication Server.

3) Make a backup of your Magaya database.

4) Stop the Magaya Database.

5) Open the Magaya Database Server Agent dialog box from the taskbar

6) Click on the “Tools” button, and select “Shrink Database”. A wizard 
opens. In the wizard, the following procedures are checked by default 
(ensure they are checked; both processes are recommended):

7) Make sure the two checkboxes are checked:

• Garbage Collection: This process will find and clean up files that are 
no longer in use

• Shrink Database: This will run a process to reduce the size of the 
database by reusing the space that the Garbage Collection process 
freed up. The Shrink process also moves data objects closer together 
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so it is easier for the system to access them, similar to defragmenting 
a hard drive.

8) Type “Yes” in the box to proceed.
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9) Click the “Start” button. The length of time this will take depends on the 
size of your database.

When the process is completed, a dialog box tells you the size of the data-
base.

10) Click the “Finish” button when the process is completed.

11) Start the Magaya Database.

12) Start the Magaya Communication server.

The system is now optimized to save data more efficiently in the future. You will 
not need to perform this task again. The system is ready to use.

Memory Usage

To set how much RAM you want the system to use, follow these steps:

1) Open the Magaya Database dialog box from the taskbar to perform the 
next optimization.

2) Click the Options button. A dialog box opens.
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3) Click the “Performance” tab.

On the Performance tab is an option to allocate additional memory for the 
Magaya system to use.

If your hardware has more memory, click and move the slide bar to 
increase the amount of memory you want the system to use.

4) Click “OK” to save the setting.
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Security: Server Authentication

Administrators can set the level of authentication required by users to log into 
the system. This is set in Maintenance > Configuration > Security. There are two 
options: Application-level or Database-level authentication.

The Database-level authentication is stronger than the Application-level 
authentication because users must type in their user name and password instead 
of select their user name from a list.

The following screenshot shows Application-level authentication:

To change the authentication option for the database level:
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In Maintenance > Employees:

1) Create user names for all employees, including yourself, if you do not have 
them already. If you do not create user names, the system will create them 
for you during the process.

2) Create an employee for the Magaya Communication Server.

The Communication Server also logs into the database. You need to create 
a user name and a password for the Communication Server so it can 
connect to the database.

On the User tab, also create a user name for the Magaya Communication 
Server.

3) Make a note of the user name and password for the Magaya Communica-
tion Server, and make sure you know your user name and password. You 
will need both to log in again.

Tip: To help keep track of login information, you can export employee 
user names via the Actions button in the Employee list view, or create a 
report by Name and print or email it.

Continue with the next steps:
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In Maintenance > Configuration > Security:

1) Click the “Database-level authentication” option.

2) Click “Save”.

Confirm that you want to perform the operation.

If you do not have user names, the system presents this message:

3) While this screen is open, stop the Magaya Communication Server. Wait 
until it notifies you it has stopped.

The system asks you to confirm your choice:

4) Restart the Magaya Communication Server.

5) Close your Magaya Explorer.

6) Right-click the Magaya Communication Server icon, and select the option 
“Database Credentials”. Enter the user name and password of the Magaya 
Communication Server. Restart it.

7) Open Magaya Explorer and log in with your user name and password.
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JavaScript Basics

In addition to using formulas to calculate tariffs and rates in Magaya software, 
you can use JavaScript.

Variables

You can use variables in your JavaScript code. Make sure you do not declare any 
variable with the same name in your functions; this will obscure the variables 
that are already defined in the Magaya system.

Here is the list of these variables:

The return keyword:

When you are writing a JavaScript function to perform a calculation, you need 
to return the calculated value by using the returnkeyword.

Example:

This function will return 3 times the value of G. The return keyword not only 
returns the value, but also ends the flow of the function.

Table 1: Variables

Variable Name

P Pieces

W Chargeable Weight

G Gross Weight

V Volume

A Value

T Time

L Volume Weight
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Basic Operators

To perform mathematical operations such as addition and multiplication, the 
operations must be represented with operators to get the results you want. Here 
are the most useful operators available in JavaScript:

By combining these four basics operators, you will be able to make almost any 
mathematical expression you desire.

The evaluation priority of the operators determines the order in which the 
expression is evaluated. Multiplication and division are evaluated first, and then 
addition and subtraction are evaluated.

To change the evaluation order of an expression, use parenthesis. Parenthesis 
increase the evaluation priority of the surrounded portion to the highest 
possible priority.

Example:

This example will evaluate the expression in the following order:

1) G + 10

2) The result of G + 10 will be multiplied by 3.

3) The result of step 2 will be divided by 4.

Table 2: Basic Operators

Operation Operator Example Priority

Addition + X = V + 5; Lower

Subtraction - X = P - 2; Lower

Multiplication * X = 10 * G; Higher

Division / X = G / 1.5; Higher
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Assignations

Sometimes when writing functions or formulas, we need to hold temporal 
values some place. To accomplish this we use variables.

An assignation is the process of making a variable equal to a given expression. 
Let’s see an example:

This example shows how assignations work, similar to the previous example but 
with differences:

1) Calculates G + 3 and hold the result in to x.

2) Calculates 3 * x and then divides it by 4; where x is holding the value of the 
previous assignation

3) Returns the value held in y

Useful Mathematical Functions

There are some mathematical functions that can be used when programming in 
JavaScript to help the calculation of more difficult expressions. Here are some 
of them:

Table 3: Mathematical Functions  (Sheet 1 of 2)

Function Description Example

Math.round (x) Rounds x to the immediate 
higher or the immediate 
lower integer value using the 
approximation rules and 
returns the resulting value

y = G * 4; m = 
Math.round(y); return m;

Math.floor (x) Returns the immediate 
lower integer value

return Math.floor(4.4);

Math.ceil () Return the immediate 
higher integer value

return Math.ceil(5.6);
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Remember that JavaScript is case sensitive. Functions and variable names must 
be written exactly as they were created, using the same upper case and lower case 
characters.

Conditionals

Your functions will not always be a trivial sequence of statements executed in 
the very same order. Sometimes you will have to take a different path to meet 
the desired results. To do that, you will need to control the flow of your 
program.

If (condition) :

This construction will allow you to make a decision in your code based on a 
given condition.

Example:

Let’s suppose that we want to get a result based on the value of volume. We want 
to return twice the value of the volume but it can’t be less than 20. If it’s less than 
20 we just want to return 20. Here's how to do it:

In this example, the value of 2 times V will be held on the variable a. Then this 
value will be compared to 20, and here the decision is made: if the value is less 
than 20, let’s make it 20. Then the resulting calculation is returned.

Math.min (x, y) Returns the minimum value 
between x and y

return Math.min(W, V);

Math.max (x, y) Return the maximum value 
between x and y

retrun Math.max(W, V);

Math.abs (x) Return the absolute value of 
x

return 2 * Math.abs(W - G);

Table 3: Mathematical Functions (Continued) (Sheet 2 of 2)

Function Description Example
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Comparison Operators:

To evaluate conditions, we used comparison operators such as less than. The 
following are the most commonly used ones:

If (condition) ... else...

This construction works just like the if (condition) construction, but here we 
have the possibility to take some action in the case of the evaluated condition is 
not met.

Example :

Consider you’d like to calculate the following:

• If the volume (V) is greater than the weight (W), return the volume times 
4.5

• Otherwise, if the volume is less than or equal to the weight, return the 
weight times 5

To accomplish that let’s use the if (condition)… else… construction:

Table 4: Comparison Operators

Comparison Operator Example

Equal to = = if (G == 2) ...

Different to ! = if (G != 2) ...

Greater than > if (G > 4) ...

Less than < if (G < 7) ...

Greater than or equal to > = if (G >= 8) ...

Less than or equal to < = if (G <= 10) ...
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Note that a pair of braces ({}) was used to make a statements group. The purpose 
of this is to tell the JavaScript interpreter that not only the first statement 
following theifclause has to be executed when the condition is met, but the 
complete block of statements into the braces.
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Using the Script Columns Feature

Introduction

Scripts written in JavaScript can be used to calculate information and display it 
in lists or reports in your Magaya software.

The Script Columns feature can be found on any “Choose Columns” dialog box 
in your system, including lists in the Warehousing folder, the Accounting 
folder, Maintenance, and other lists or reports.

An example of a script column is if you need to know the number of days cargo 
has been on hand. The script in this example will calculate the number of days 
based on the date the cargo arrived and today’s date.

JavaScript can also be used in custom fields. See:

http://knowledge.magaya.com/#/article/custom_fields

Steps to add a script column to a list

Go to the Actions button in a list or report (or right-click an item) and select 
“Choose Columns.”
 306



Chapter 9 Using the Script Columns Feature
When the “Column Settings” dialog box opens, click the arrow on the side of the 
button “Add Columns” and select the “Add Script Columns” option from the 
dropdown:
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The Script Columns dialog box opens:

When you add scripts for columns to your Magaya system for this transaction 
(such as the Warehouse Receipt list), they will appear in this dialog box. If you 
don’t have any scripts saved yet, the list will be blank.
 308



Chapter 9 Using the Script Columns Feature
Click the “Add” button to create a new script column. In the dialog box that 
opens, enter your script:

1) Enter a name for the column in the “Display Name” field. Since this is the 
name that all users of the system will see in the list, choose a name that 
describes the function of the script. For the example that calculates the 
number of days cargo is on hand, we entered the Display Name: Days On 
Hand. The Internal Name field fills in automatically as you type, using 
lower case letters and substituting an underscore line for any spaces. The 
Internal Name is used by the Magaya system.

2) The Type field is used to determine the format of the output (what will 
display in the list). The system will use this information to format the data 
that will display in the list. The field has a dropdown menu with the 
following options:

• Text

• Integer (this displays a number)

• Date

• Yes/No

3) Option: The checkbox “Use direct access to database (without xml)” will 
tell the system to use a different scripting language instead of xml, which 
will improve the speed of processing a transaction. This is useful for large 
transactions that will calculate large amounts of data. As of the date of this 
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documentation (April 2015), documentation is only available for this 
process from Magaya Corporation. Contact your sales representative or 
Implementation specialist to customize a transaction with this method.

4) Click the “Edit” button to open a window for writing the code:

The function brackets are already included. Enter the code in this screen. 
You can also use (refer to) JavaScript functions that you already entered in 
the JavaScript library that is located in the Maintenance > Configuration 
> JavaScript.

This example uses a function created in the JavaScript library called 
DaysInStorage that calculates the days an item has been on hand.

When you complete the script code, click OK to save it and return to the 
Script Column dialog box.

5) Click OK to close that box and return to the Script Columns box. The 
script code you entered will be displayed in the list.

The script column will also be displayed in the Column Settings dialog box. 
Move it to the place in the list that you want it to appear.

When you click OK, the column heading now displays in your list. It can be 
displayed in other lists that are related to it by choosing the “Add Related 
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Columns” option from the Choose Columns dialog box. This column will also 
be available to create reports.

The source of the column type will show in the dialog box also, indicating if the 
column is a standard one included with the system, a related column, etc.
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Customize Reports

You can enhance and customize the format of reports. Change the font, color, 
size, etc. of the different elements in the report such as company name, title, 
subtitle, columns headers, rows, etc.

Options

Any report that you create opens in a view that includes a toolbar at the bottom 
of the report. To customize the report:

1) Click the “Configure” button.

A dialog box opens with three tabs: Header Info, Fonts, and Numbers. The tabs 
available depend on the report you are viewing.

TheHeaderInfo tab displays your company name, the report title, and subtitle; 
you can change any of these as needed.
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2) Click the “Fonts” tab. Select the element you want to customize such as the 
Header – Company Name. Make changes to the font and click OK.

3) Click on the “Numbers” tab for the following options:
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For example, to display negative numbers in red, select the options above to see 
the numbers in your report as follows:

Other options available:

• Display whole numbers or numbers divided by 1000

• Output numbers using the thousand separators, for example: 1,000,000.00

• Display negatives values in red or in parenthesis

The Balance Sheet, P&L, and other reports enable you to view the report on a 
cash basis or accrual. For more on cash basis reports, see the following Knowl-
edgebase article:

http://knowledge.magaya.com/#/article/cash_basis_reports

Choose Columns:

1) Click the Actions button, and select “Choose Columns”.
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2) In the dialog box that opens, select the column you want, or click the “Add 
Column” button to open a new dialog box with more choices.

In this “Column Settings” dialog box, you can adjust the width of any column, 
move it up or down, or you can type over the name of the column to change it 
to a name you want.

If you need to reset a report back to its original columns, click Actions > Set 
Default Columns.

The currency of reports can be changed (if you set you system to multicur-
rency), you can filter information in a report, and export a report from your 
Magaya system.

Save Custom Report:

The “Save” button has two options: one saves the report as is; the other allows 
you to save the same report by another name (previously the system would 
overwrite the report). This feature is especially useful when you want to create 
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another report that is similar to the first one; now you do not have to start from 
scratch to build it.
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A
Accounting document numbers

set up 116
Administrator task

Server Authentication 296
Air waybill numbers 146
Air waybill, expand details 122
Amendment 77
AMS 142
Assign customer account numbers 128
Attachments not visible 291
Authentication levels 158
Automate charges per customer 11
Automated accounting 6
Automatic creation tab 8

B
Backup database 275

automate (overview) 280
automate full backup 281
automate incremental backup 282
full manual 275
incremental 277

bar code 222
Bill of Lading, expand details 123
Bill, create periodic 26
Bill, create recurrent 20
Blobs 279, 290

Bookings Online set up 135

C
Cargo manifest, expand details 123
Carrier Contracts

add a new 76, 79
add multiple rates 79

Carrier rates 42
create reports 48

CASS 172
Charges, automate 6
Charges, dependent 9
Charges, prioroty 9
Charges, show or hide in documents 9
Check, create recurrent 20
Clauses, set up 161
Client Contracts 75, 86
Code, enter JavaScript 154
Commissions

set system-wide 133
Commissions, inventory 94
Commissions, salesperson 89
Commodity Type, in Rates dialog box 61
Commodity Types, set up 166
Company type, set up 111
Configuration menu 108
Configure ocean shipment settings 150
Contact Magaya 3
Contract Tab 46
BOOKTITLE i



Contracts 74
amendment 77
carriers 76
clients 86

Contracts Manager 74
Control

link with data source 196
Credit Limits, set up 116
Custom Fields

advanced filter 192
deactivate 186
detailed set up steps 179
examples 176
internal name 180
reports 188
set up 152
tab 177
type screenshots 181

Custom rate 59
Customer registration via Custom LiveTrack
127
Customs, US 142

D
Database

performance 288
Database server agent 272
Deleting transactions 289
Denied Party Screening 120

configure 121
Discount Payment Terms, configure 173
Divisions 264

assign employees 267
create report 269
detailed set up steps 264
set up 167

Document numbers
consecutive order 113
duplicates 116
Prefix, Suffix 115
set up 113

Drop ship configuration 133

E
Email, set up 131
Events

add new 168
automate creation of 110
define 168

F
Fields 198
File extension .bak 277
Fiscal printer 118
Fiscal printer RUC number 119
Fiscal printer tax rates 119
Fonts, customize reports 313
Forms

air waybill, expand details 122
Bill of Lading, expand details 123
Cargo manifest, expand details 123
set up form filling 122
show item details 124

G
General configuration options 110
General Rate Increase 63
Generate recurrent transactions 23
GRI 63

H
Help 3

I
IATA configuration 146
Incoming messages 130
Incoterms 169
Initial amendment 77
Invoice, create periodic 24
Invoice, create recurrent 13
Itemize charges 19

J
JavaScript 259

check syntax 261
comparison operators 304
conditionals 303
Database Object 259
mathematical functions 302
operators (basic) 301
variables 300
XmlDocument Object 259
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L
Labels, set up printer 125
Landed cost, configure 116
Lists, set order 110
Lock Air Waybill or Bill of Lading numbers 116
Log file 273

M
Magaya Database Server Agent 272
Magaya Document Designer 195

alignment 225
Code pane 206
controls 196
create new template 252
custom field internal name 248
custom fields 247
Design pane 205
fields 210
file size limit 255
font 226
graphic elements 196
how to open 201
Insert 208
insert image 235
interface 205
JavaScript 259
Layers 208
modify existing templates 224
multiline text 227
publish 254
reload data 248
resize fields 225
Schema 209
tables 228
x-path 228

Measurement units, set up 125
Multiple rates 79

O
Online Bookings 135
Online Payments 136
Online Sales Orders 138

automate charges 140
cancel 140

Online Shipping Orders 141
Outgoing messages 131

P
Page numbers, Magaya Document Designer
249
Participation, agent commissions 104
Participation, salesperson commissions 90
Payment Terms, configure 173
PDF optimization 160
Performance configuration 160
Periodic invoice 24
POD 144
Pricing configuration 133
Print labels, set up 125
Print, pre-printed forms 221

Q
Query Rates 50
QuickBooks, set up export options 116

R
Rates

compare purchasing and selling rates 56
create a custom rate 59
discount from carrier 85
enter your own rates 80
expire 83
filter 66
modify 72
multiple 79
RORO 46, 82
set by range 45
transform from existing 64

Rates, query 50
Rates, standard 54
Recurrent accounting transactions 13
Recurrent bill 20
Recurrent check 20
Recurrent invoice 13
Recycling 288
Refresh database 274
Reports, by custom field 188
Reports, choose columns 314
Reports, customize 312
Restore data 284
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Roll On Roll Off (RORO) 46, 82

S
Salesperson commissions 89
Schema

elements 209
Search by customer name or account number
129
Security configuration 157
Selling rate (Standard) 48
Server Authentication 296
Shipment Documents set up 162
Shipment numbers 114
Shrink database 292
Standard client rates 54

create reports 57
Start database 273
Stop database 274
System Alerts 165
System startup 160

T
Tariff 29

create new 30
Task Types 171
Tax rates, fiscal printer 119
Transaction Log 289

clean up 156
Transaction Log, set up 155
Transaction Tracking, set up 127

U
Unstructured data 290
Users connected 274

V
Vendor, periodic bill 26
View transactions, limit list length 110

W
WMS, set up 143
Working Date Period 110

Z
Zebra printer 125
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